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1. Introduction 

1.1 Intended use 

The ANT-5 SDH Access Tester is designed to provide all the test functions required 
by engineers installing and maintaining SDH systems in the Access Network. It can be 
fitted with the optical and electrical interfaces listed below. 

 

It has independent transmitters & receivers for connection to the following interfaces: 

SDH STM-1 electrical line interface 
 STM-0 electrical line interface 
 Optional STM-1 optical interfaces, 1310 nm and/or 1550 nm wavelengths 
 Optional STM-4 optical interfaces, 1310 nm and 1550 nm wavelengths 
 Optional STM-16 optical interfaces, 1310 nm and 1550 nm wavelengths 
 ECL/NRZ STM-1, STM-4, and STM-16 electrical receive interface 
PDH E4 electrical line interface, 140 Mbit/s 
 DS3 electrical line interface, 45 Mbit/s 
 E3 electrical line interface, 34 Mbit/s 
 E1 electrical line interface, 2048 kbit/s (balanced and unbalanced) 
 T1 electrical line interface, 1544 kbit/s 
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Application software is included with the product to facilitate the measurement of 
network transmission quality and the monitoring and injection of anomalies and 
defects. 

This product is not to be used on telephone lines. The product is intended only for 
connection to circuits carrying Safety Extra Low Voltages (SELV). 

1.2 Features of the SDH Access Tester application software 

The SDH Access Tester application software provides a complete set of test functions 
for engineers who install and maintain SDH and PDH systems. Performance analysis 
is a key feature during the commissioning process, and the anomalies and defects of 
the system can be measured and recorded. The application has the following features: 

• Bit error rate testing including anomaly & defect analysis, injection. 

• Performance analysis: G.826 (ISM), G.826 (OOS), G.821, G.828, G.829, M.2100, 
M.2101 & ANSI 

• Overhead testing including path tracing and injection 

• Results printing and export (to PC) 

Optional software for the ANT-5 is discussed in section 5. For more information on 
purchasing any of these specific features please contact the nearest Regional Sales 
Office as listed on the back of the manual. 

1.3 ANT-5 Software version summary 

Software Version Base Software Optional Software 

11.0  ATM Ping (Ping, Reply to 
Ping, Trace Route) 
ATM enhanced (AAL-2 
and AAL-5 support, 
Channel Traffic Analyzer, 
Extended ATM traffic 
analysis) 
IMA monitor 

10.2  PLCP support 
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Software Version Base Software Optional Software 

10.0… STM-0 electrical  
Thru Mode/ intrusive 
Ext. Ref.Clock: 2048 kbps, 2 MHz, 
1544 kbps, 1.5 MHz 
Pointer generation (INC/DEC) 
M13 demux of DS3 signal to DS1 or 
64k channels 
TCM generation 
Bit Pattern 2E-11 
QRSS20 pattern 
Compatibility with 2M ATM devices 
Enhanced language support for 
Remote Operation* 
(*Simplified Chinese support 
requires Windows Code Page 936.) 

 

09.00… Autoconfigure 
Pointer generation 
K-byte capture 
DS3 code error generation 
PDH external timing 
Service disruption 

VC3 ATM mappings 
DS1 ATM mappings 

08.00… G.828 and G.829 performance 
analysis 
Inline monitoring 
Offline viewer 
E1 PCM30C 
STM-16c* 
Optical power measurement* 
T1 interface, including AMI code* 
ECL NRZ measurement* 
Online help 

ATM 
Sa bit monitoring 
(requires PDH Mux 
option) 
ATM Channel Explorer 
ATM cell BERT 
ATM VC-4c mapping 

 (*These features are available on selected hardware versions.) 

07.00… E1 Code Error generation and 
measurement 
Alarm burst error generation and 
detection 

AU3 & VT* Mappings 
(*requires SONET option) 

06.00… Clock offset SONET 

05.00… AU Pointer Value – SS bit monitoring
Tributary Scanning 
Nx64 
FTP functionality 
User Preferences 

PDH Mux/DeMux 
(inc Sa bit generation) 
VC4-4c Mapping 
Remote Operation 
Remote Control 
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Software Version Base Software Optional Software 

04.00… Repetitive BERT 
APS Measurement  
Pointer Analysis 
Round Trip Delay 

 

03.00… Tandem Connection Monitoring 
M2101 performance analysis 

 

1.4 Physical layout and connectors 

The ANT-5 has the following external connectors at the rear and side: 

STM-n 
Optical Tx, Rx 

FC/PC 
1310 nm 
and/or 
1550 nm 

Tx and Rx connectors for STM-1, STM-4 or 
STM-16. 
Note: The optical interfaces are optional. 

STM-0, STM-1, E4, 
DS3, E3 
Electrical Tx, Rx 

BNC, 75Ω, 
nickel plated 

Unbalanced electrical Tx and Rx connectors 
for STM-0 and higher-order PDH payloads 

E1 
Tx, Rx 

BNC, 75Ω, 
nickel plated 

Unbalanced electrical Tx and Rx connectors 
for E1 PDH payload 

T1 
Tx, Rx 

Bantam, 100Ω Balanced electrical Tx and Rx connectors for 
T1 (1.544 Mbps) PDH payload 

STM-n 
Rx 

SMA, NRZ ECL input 

Ext Clk input BNC, 75Ω, 
nickel plated 

Unbalanced electrical clock input for Tx at 
2048 kbps, 2 MHz, 1544 kbps, 1.5 MHz 

COM 1 
RS232C 

D type 9-way 
Male 

V.24 serial port 
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The ANT-5 has the following external connectors on the left side: 

E1 RJ-48, 8-wire 
(6 wires used) 

Balanced 120Ω electrical connector for E1 
PDH payload 

19V DC power 
3A 

2.1 mm 19V Power supply input. For use with type 
PPS-2 only 

<···> RJ-45 10 base T – TCP/IP Ethernet port 

 

Note: For reliable operation we recommend only using JDSU cables (e.g. K168, 169) 

!
 

WARNING: Section 1.5, Safety instructions, should be read before connecting 
cables to the ANT-5. 

Note 1: Optical connectors, where fitted, are provided with dust caps which should be 
used whenever an optical lead is not connected. 

Note 2: Care must be taken not to connect a long-haul (high power) transmitter 
directly to the receiver, or not to short-circuit the Tx and Rx optical interfaces, since 
this can overload or even damage some receiver modules. By connecting an external 
optical attenuator (as supplied) this restriction can be overcome. 
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1.5 Safety instructions 

To ensure that the ANT-5 is maintained in perfect condition and that it operates safely 
at all times, the instructions which follow should be read and observed. 

1.5.1 Correct usage 

The ANT-5 should only be used for the purpose and under the conditions for which it 
is intended. Operation outside these conditions may be dangerous or may damage the 
instrument. Refer to Section 1.1, Intended use, and Appendix A – Specifications 
and ordering information for further details. 

1.5.2 Connection to test circuits carrying dangerous voltages 

!
 

WARNING: Dangerous voltages may be present on telecom circuits. 

Telephone lines can have potentially dangerous voltages. The BNC, bantam and RJ 
connectors must be connected to Safe Extra Low Voltage (SELV) circuits only and 
must not be connected to any circuit carrying dangerous voltages. 

1.5.3 Laser safety 

The following only applies if optical interfaces are fitted: 

.  
WARNING: Class 1 Laser Product. 

Optical radiation with wavelengths of 1310 nm and/or 1550 nm is present at the optical 
connectors. Each interface is active if the yellow LED next to the connector is on. The 
laser warning icon  is also displayed with a yellow background when the ANT-5 
laser source is active. Maintenance and repair work on the laser sources should only 
be carried out by qualified service operatives familiar with the risks involved. 

.  
WARNING: Invisible laser radiation. 

Laser light can cause irreparable damage to the eyes, particularly to the retina. 

• To deactivate the ANT-5 laser source (Tx), clear the Laser On checkbox in the 
Interface Setup Tx panel. See Section 4.3.1.2 for further details. 

• Never look directly into the generator outputs or the connector end surfaces of the 
connected cables (free ends) if the laser sources are activated. 

• Never use a microscope to check generator outputs if laser sources are activated. 

• Do not activate laser sources until all measurement connections have been made. 
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1.5.4 Cleaning optical connectors 

To maintain error-free operation, the ANT-5 optical connectors should be regularly 
cleaned using a pressurised optical duster which is intended for the purpose. The 
optical connectors are provided with dust caps which should always be used when an 
optical patch lead is not connected. 

Patch lead connectors should also be cleaned by an approved method, such as a 
pressurised optical duster or a cassette-type cleaner, according to the manufacturer’s 
instructions. Dust caps should be fitted to the patch leads when they are not in use. 

1.5.5 Optical attenuators 

!
 

WARNING: Equipment damage 

Care must be taken not to connect a long-haul (high power) transmitter directly to the 
receiver, since this can overload or even damage some receiver modules. By 
connecting an external optical attenuator this restriction can be overcome. 

1.5.6 Faults and damage 

If it is considered that the instrument can no longer operate safely, it should be taken 
out of service, labelled with the fault condition and secured against unintentional use. 
The following are situations where this may be the case: 

• if the instrument shows visible signs of damage 

• if the instrument no longer operates correctly 

• if the instrument has been subjected to any stresses (such as storage and 
transport) where the permitted range limits were exceeded. 

If the rechargeable battery pack develops a fault it can be replaced locally in an 
appropriately equipped workshop. See Section 7.6.2, Replacing the ANT-5 battery 
pack, for further details. 

With the exception of the battery pack, there are no user serviceable parts in the 
ANT-5 or its accessories. Do not attempt to open the case of the instrument – any 
attempt to do so will invalidate the warranty. 

If maintenance or repair of the instrument is required, contact the nearest JDSU Sales 
Office or Technical Assistance Centre. For locality information visit our web site, 
www.jdsu.com, or contact the nearest Regional Sales Office as listed on the back of 
the manual. 

Refer to Section 8, Customer support for further details. 
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1.5.7 General cleaning 

The outer surfaces and bumpers of the ANT-5 may be cleaned with a cloth slightly 
dampened with water or a mild detergent. Abrasives and solvents must not be used, 
as they will damage the finish and may remove the labelling. 

Switch off and disconnect all cables before cleaning and do not allow water or any 
other substance to enter the instrument through the keyboard, connectors or card slot 
locations. 

1.6 Power supplies 

The ANT-5 is supplied with a built-in NiMH rechargeable battery, a PPS external 
power supply and a mains cable. The power supply is connected to the ANT-5 via an 
integral cable and jack socket. 

The external power supply acts as a charger unit when the instrument is switched off. 
When external power is connected, the battery LED  above the screen will be 
green. See Section 2.5, LED and on-screen indicators, for further details. 

!
 

WARNING: The ANT-5 must only be operated from its internal battery or from 
the included PPS power supply. Ensure that the correct power supply is 
connected to the appropriate ANT-5. Refer to section 1.4 for further details. 

1.6.1 Battery charging 

The internal NiMH battery is charged automatically when the instrument is connected 
to a live external power supply. An adequate charge will be reached within 3 hours if 
the instrument remains switched off whilst charging. It will automatically switch to a 
trickle charge mode when fully charged or when the instrument is switched on. 

Note: If the temperature of the operating environment is too high, the instrument will 
automatically select trickle charge mode to avoid overheating. 

Before the instrument is used for the first time it is recommended that the battery is 
conditioned by running through two full discharge/recharge cycles as described in 
Section 7.6.1, Battery conditioning. This procedure will also establish the initial 
conditions for the battery charge indicator. 

1.6.2 Low battery 

When no external power supply is connected and the battery charge is getting low, the 
battery LED  above the screen will come on as a steady red light and the 
instrument will emit an audible warning. As the battery gets very low the battery LED 
will start to flash and further audible warnings will be emitted. An external power 
supply should now be connected as the instrument will switch itself off approximately 
90 seconds after the battery LED starts to flash. 
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1.6.3 Displaying the battery charge indicator 

An on-screen display showing battery charge level is activated by selecting Battery 
Level from the Tools menu. This display can be cancelled by pressing the Esc key. 

Note: If the Battery Level indicator shows the warning ‘Reading may be inaccurate’, 
the battery conditioning procedure described in Section 7.6.1 should be followed. 
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2. Getting started 

2.1 Switching on and off 

The ANT-5 can be switched on in two ways – either manually, by pressing the On key, 
or remotely by using a computer to apply a Ring Indicator (RI) signal to the serial port. 
See Appendix C – Serial port and adapter cables. 

In normal use the ANT-5 should be switched off by briefly pressing and releasing the 
Off key. This allows the power-down sequence to be controlled by the ANT-5 system 
software, which will ask the user to confirm or cancel the power-down if a test is 
running. 

Note: For ease of use it is not necessary to close applications before switching the 
unit off. 

In exceptional circumstances only, for example if there is an instrument malfunction, 
the ANT-5 can be forced to switch off without software control by holding the Off key 
down for more than 6 seconds. It can then be switched back on normally. 

Note: The ANT-5 automatically saves results at certain intervals during a test. If you 
switch off the ANT-5 by holding the Off key, you may lose test results that have not 
been saved.  

2.2 Start up screens 

When the instrument is switched on, the ANT-5 self-test software runs automatically 
and the start-up logo is displayed on the screen. After this, the screen briefly displays 
information about system version numbers and the ANT-5 hardware. 

Note: During the start-up process, clicking noises will be made by relays inside the 
instrument. This is a design feature and is part of the normal start-up. 
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Once the self-test is completed the 
application launcher screen will be 
displayed with the SDH Access Tester 
application represented by the ANT-5 
icon as shown. 
To launch the application, highlight 
the ANT-5 item and press the Enter 
key. A screen with version information 
will be displayed whilst the instrument 
recovers its previous configuration 
from non-volatile memory and sets up 
its measurement hardware. This will 
be replaced by the Signal Structure 
setup page when the application is 
ready for use. 

 

For further information on configuring and running the application, see Section 4, The 
SDH Access Tester Application. 

2.3 Menus 
The operating characteristics of the 
ANT-5 are controlled by sets of 
hierarchical menus which can be 
displayed or hidden by pressing 
Alt+Menu (press Menu whist holding 
down the Alt key). The highest level 
of the menu structure is represented 
by a bar at the top of the screen with 
one choice highlighted. The System 
menu is shown here as an example. 
Lower levels in the menu structure are 
displayed as cascaded lists which 
appear beside their parent menus.  

Use the direction keys to move the highlight around each menu and then press Enter 
to either select an item or to display the next menu level in a similar way. Press Esc to 
close the current menu and move up one level. 

When the setup menus are hidden and then displayed again, the same level will be 
shown if it is valid to do so. If a test is running, the application will not update the 
displayed backdrop while a menu is displayed in the foreground. 
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2.4 Message boxes 

Message boxes pop-up in front of any other screen contents in the middle of the 
screen and are used to verify certain actions by the user. The message box contains 
labelled buttons which should be ‘pressed’ to carry out the action (use the directional 
keys to highlight the appropriate button and then press the Enter key to operate it). 

The box will remain on the screen until a key associated with one of the buttons is 
pressed or until one of the default keys Enter or Esc is pressed. Enter is used to 
accept the highlighted choice and Esc is used to cancel the message box without 
accepting any choice. 

2.5 LED and on-screen indicators 

The top portion of the screen is used by the tester application to simulate LED 
indicators on-screen in order to display information which is relevant to the current 
setup of the application. The behaviour of the on-screen LEDs can be set to be 
latching or non-latching in the LEDs section of the System menu, which can be 
displayed by pressing the Alt + Menu key at any time. For further details See Section 
4.8, On-Screen LED Indicators. 

The four LEDs above the screen are used for general status information as follows: 

 
Alarm LED 
Signal LED 

The non-latching Alarm and Signal LEDs are used by the 
tester application to summarise the test status, even if the 
screen has been blanked to save power. 
The Signal LED will be green if there are no alarms or errors 
to display on the on-screen LEDs. In this case the Alarm 
LED will not be lit. 
The Alarm LED will be red if one or more on-screen LEDs 
are shown in red to indicate alarm or error conditions. In this 
case the Signal LED will not be lit. 

 Screen LED Steady green indicates that the screen has been blanked to 
save battery power. Press any key to restore the screen. 
See Section 2.13, Power saving features. 

 Battery LED Green indicates that the ANT-5 is connected to an external 
power supply. Flashing green indicates fast charge; steady 
green indicates trickle charge. 
Red indicates that the battery charge is low and an external 
power supply should be connected as soon as possible. 



Getting started  

Page 26 ANT-5 

2.6 Using the keyboard 

i1 2
ABC

3
DEF

4
GHI

5
JKL

6
MNO

7
PQRS

#

A
B
C

Esc

Alt On Off Menu

Del

9
WXYZ

8
TUV

0
SPACE

 

 

On
 

Off
 

On, Off keys Turn the ANT-5 on and off. 

 

Beeper/ 
Contrast key 

Turn the beeper on or off when the SDH Access 
Tester application is running (for audible notification 
when defects and anomalies are detected). 

Alt
 + 

 

Alt+ Beeper/ 
Contrast key 

Press with the Alt key held down to display a scale 
for adjusting the screen contrast. 

Menu
 

Application 
Menu key 

Displays the application menu, or turns off the menu 
if the menu is already displayed. 

Alt
 + 

Menu
 

System 
Menu key 

Displays the system menu, or turns off the menu if 
the menu is already displayed. 

 

Directional 
keys 

The directional keys are used for moving around 
screens and setup menus. 

 

Enter key Accept the current selection or operation. 

i  Information 
key 

Display some basic help or system information on the 
screen. Clear this by pressing the Enter or Esc keys. 
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Del
 

Delete key Delete text (backspace). 

 Function keys The function keys are used by the tester application. 
Active keys are labelled at the bottom of the screen. 

Esc
 

Escape key Cancel the current selection or operation. 

Alt
+ 

Esc
 

Alt+Escape Use Alt+Esc to switch between applications. See 
Section 3.1.1, Switching . 

A
B
C  

ABC key The ABC key gives access to the alphabetic 
characters on the number keys. Press once to toggle 
between the modes. 

2
ABC

 
Alphanumeric 
keypad 

Multipurpose telephone-style keypad. Refer to 
Section 2.6.4, Using the alphanumeric keypad. 

Alt
 

Alt key Extends the functions of the standard keys (see 
above). 

Alt
 + 

#  

Alt+Hash Use Alt+Hash to save the current screen in a file or 
send it to a printer on the serial port, depending on 
the Screen Dump setting in the Printer section of 
the System menu. 

 
Backlight key Toggle the backlight between high and low level. 

2.6.1 Adjusting the screen contrast 

To adjust the screen contrast, press the Beeper/Contrast key whilst holding 
the Alt key down. 

 

The contrast is increased or decreased using the directional keys. A scale will be 
displayed on the screen which reflects the contrast level. To remove the scale from 
the screen, press the Enter key to accept the new setting or the Esc key to cancel it. 

The ANT-5 will continue to operate during contrast adjustment but will not receive any 
keypad input until the adjustment is completed. 

2.6.2 Switching the beeper on or off 

The ANT-5 has an internal beeper which can be used to provide an audible 
notification when defects and anomalies are detected. When the SDH 
Access Tester application is running, this feature can be turned on or off by 
pressing the Beeper/Contrast key. 
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#

2.6.3 Function keys 

The six unmarked keys at the top of the keyboard are function keys which 
can be used in different ways by applications. Labels will appear along the 
bottom edge of the screen to show that a function key is active and to 
indicate its purpose. 

2.6.4 Using the alphanumeric keypad 

The alphanumeric keypad is normally used for entering numbers in setup menus but it 
can also be used for entering alphabetic and special characters. Entry boxes generally 
have a character on their right hand side to indicate that a specific type of data is 
expected, such as a b for binary, d for decimal or h for hexadecimal. 

The ABC key is used to enter and leave the extended alphabetic mode, in 
which strings of alphanumeric and special characters can be entered by 
using repeated key presses punctuated by short pauses. The current mode is 
indicated in non-specific data entry boxes by an A or a 1. 

A
B
C  

Each key has a set of characters associated with it, and the sequence will repeat in a 
cycle until either a different key is pressed or a pause of one second occurs. 

For example, repeatedly pressing the 9 key will display the sequence W-X-Y-Z-9-W-X-
Y… until there is a pause or another key is pressed. The last character will then be 
accepted and the screen cursor will advance to allow entry of another character. To 
switch between upper and lower case letters, hold any letter key down for one second 
or more. Use the Del key to backspace over any mistyped characters. 

The  and  keys on either side of the 0 key are used for entering non-

alphanumeric characters. The sequence for the #  key includes the following 
characters: - # + ! , : ” ’ & ( ). The 0 key can be used to enter space characters. 

2.6.5 Changing the keypad settings 

Keypad settings such as the length of 
the Alpha Delay pause can be 
changed in the Keypad section of the 
Preferences menu. 
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2.7 Printing the current screen 

The current screen can be saved in a file or sent to a printer on the serial port by 

pressing the #  key whilst holding down the Alt key. The Screen Dump feature can 
be turned off or directed to either a file or the printer in the Printer section of the 
System menu. 

The ANT-5 will sound a series of beeps when the screen has been saved or printed. If 
the screen is being saved in a file, it is particularly important not to remove the card 
before these beeps have indicated the end of the process. 

2.7.1 Printer configuration 

The Printer section of the System 
menu allows the selection of the 
current printer driver and the current 
printer port, which can be set up for 
printing to the serial port or to a file. 
The parameters for each printer 
driver, such as paper size, custom 
paper dimensions and unprintable 
area, can also be set. 
The available drivers support the 
following printers: HP Deskjet, HP 
Thinkjet, Epson 9-pin, Epson 24-pin, 
and an ASCII printer.  

A test page facility is provided to ensure that a printer is correctly set up. The test 
page contains information about the current printer set up such as the driver name, 
printer port settings and paper dimensions. The test page also has a rectangular 
border that delimits the printable extent of the paper. This can be used to ensure that 
the paper size and unprintable area are correct. If the border is truncated (i.e. a 
complete rectangle is not visible) then the unprintable area may be set too small or the 
paper size too large. Conversely, if the border is too far from the edge of the paper 
then the unprintable area may be set too large or the paper size too small. 

Note 1: The SDH Access Tester application also uses the Menu key to provide a drop 
down facility which can be used to print a comprehensive results and setup report via 
the serial port (See Section 4.7). To use this feature successfully, it is important to 
have the correct Printer Driver and Serial Port settings rather than relying on the 
simple test data mentioned in Sections 2.7.1 and 2.8. 

Note 2: The K1589 serial-to-parallel adapter cable supports printing from the ANT-5 to 
printers with a parallel port. See Section 11.3 Serial-to-parallel adapter cable for 
details. 
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2.8 Serial port 
The ANT-5 can be connected to a 
printer via the 9-way, male, D-type 
connector. The configuration of the 
serial port parameters such as baud 
rate, parity and stop bits can be set in 
the Serial Port section of the System 
menu. 
A facility to send an ASCII test pattern 
to the serial port is provided as an aid 
to setting up peripherals. This is 
particularly useful for setting up the 
serial connection for a printer since 
most printers will print ASCII text sent 
to them. 

 

See Appendix C – Serial port and adapter cables for a diagram of the serial port. 

2.8.1 Comms menu 

A remote operation option is available for ANT-5, (See Section 5.4), enabling the unit 
to be operated remotely from a Windows PC over Ethernet. 

Note: Care should be taken not to confuse the E1 120Ω (RJ-48) and the Ethernet port 
<···> (RJ-45). 

The greyed out MAC Address of the 
built-in Ethernet port is shown in this 
graphic. Your IT department will need 
to know this when assigning the IP 
address. 
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For PPP operation the ANT-5 acts as 
the server and is responsible for 
assigning IP addresses, conversely 
the PC acts as the slave. 
The Peer IP Address is the address 
the ANT-5 assigns the remotely 
connected PC for that PPP interface, 
and as such is the address of the PC 
from the ANT-5. 
The Local IP Address is the address 
of the ANT-5 from the PC.  
These addresses can be edited in the 
same way as above. 

 

Note 1: The Comms menu contains a baud rate setting which should not be confused 
with the baud rate setting of the serial port. This should be set up in the Serial Port 
section of the System menu. 

Note 2: When typing in the ANT-5 IP address into a PC environment care should be 
taken to avoid any leading zeros. For example 141.169.126.076 would be replaced 
with 141.169.126.76. However, all twelve characters are needed for the ANT-5.  

Note 3: Edited IP addresses will be available after the ANT-5 has been re-booted. 

2.9 Card slot 

The ANT-5 is fitted with a CompactFlash card slot situated on the right side. These are 
used for storing set-ups and results. CompactFlash cards can be formatted in the 
ANT-5. See Section 3.2.6 for further details. 

The cards should be inserted with the label side uppermost. Press into the slot until 
firmly located. The ANT-5 will beep to indicate it has recognised the card. If no beep is 
heard refer to section 7.3. 
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2.10 Setting the time and date 
The current time and date can be set 
in the Time & Date section of the 
System menu. 
After setting the time or date, power 
off and on the instrument. Verify that 
the time and date have changed. 

Note: The time or date should not be 
changed when a measurement is 
running, since this will invalidate the 
results. 

 

2.11 Setting the time zone 
The time zone can be set in the 
International section of the 
Preferences menu. 
Be sure to change the time zone 
when you move the instrument across 
time zones. Changing the time zone 
automatically changes the time and 
date. 
After changing the time zone, power 
off and on the instrument. Verify that 
the time and date have changed. 
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2.12 Setting daylight savings time 
The daylight savings time indicator 
can be set in the International 
section of the Preferences menu. 
When you mark the Daylight Saving 
checkbox, the instrument 
automatically adds one hour to the 
current time. When you clear the 
Daylight Saving checkbox, the 
instrument automatically subtracts 
one hour from the current time. 
After making a setting for daylight 
savings, power off and on the 
instrument. Verify that the time has 
changed. 

 

Note: The instrument does not automatically adjust the time for daylight savings. You 
must set or clear this checkbox manually. 

2.13 Power saving features 
The power saving features can be set 
up in the Power Saving section of the 
Preferences menu. 
These take effect when the instrument 
has been idle for a set period of time 
with no keyboard activity. 

 

2.13.1 Using the backlight 

The screen has a backlight which can be switched between high and low level 
by pressing the Backlight key. Use the low level to save battery power.  

2.13.2 Display Saver 

When the Display Saver is selected, the screen will turn off after a set period of 
keyboard inactivity in order to save battery power. When this happens the screen LED 
( ) will come on to indicate that the screen has been blanked. The full screen 
display can be restored by pressing any key. 
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The time delay before blanking occurs can be set up in the Power Saving section of 
the Preferences menu. 

This section can also be used to set up the ANT-5 to restore the screen automatically 
when there is a change in the status of the on-screen simulated LEDs. The behaviour 
of these LEDs is controlled by the current tester application. 

2.13.3 Auto Power-off 

When Auto Power-off is selected, the ANT-5 will switch itself off after a set period of 
keyboard inactivity in order to save battery power. The time delay before this occurs 
can be set up in the Power Saving section of the Preferences menu. 

The ANT-5 will not switch itself off if a test is running. However, if the unit is 
accidentally switched off, or there is no power left in the battery, results will be saved 
in the user: device of the File Manager. These will be saved as AUTO files, with 
suffixes of .A5R, the time and date will also be present so that the results are easily 
identified. 

2.14 International features 
The International section of the 
Preferences menu can be used to 
select various international features 
including the preferred operating 
language. 

 

2.14.1 Setting the operating language 

Select the appropriate language from those listed in the 
Language section and press the Enter key. 

Note: The ANT-5 operating system will need to be re-started before this change can 
take effect. This requires turning the instrument off and then turning it on again. 
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3. The ANT-5 operating system 

3.1 Application launcher 

The ANT-5 can have one or more software applications loaded, each of which will 
have independent control over the configuration of the measurement hardware and its 
own results collection, storage and presentation. The available applications are shown 
as icons on the application launcher screen with the name of each application shown 
below the icons. 

A typical application launcher screen 
is shown here with the ANT-5 SDH 
Access Tester application 
represented by the ANT-5 icon. 
To launch an application, use the 
direction keys to highlight the name of 
the application and then press Enter. 
The application will be launched with 
its last used configuration and the 
application launcher screen will be 
replaced by an application-specific 
screen which will make use of the 
whole screen area.  

On terminating an application, the application launcher screen will be displayed again. 

3.1.1 Switching to an ANT-5 system application 

The file manager and application launcher are system applications which can be 
displayed at any time, without closing the SDH Access Tester application, by pressing 
Alt+Esc (press Esc whilst holding the Alt key down). This can be useful for changing 
the ANT-5 setup parameters without interrupting a test. 

Pressing Alt+Esc repeatedly will switch between the ANT-5 system and the tester 
application in turn. 

If a system application is using the screen whilst the tester application is running, the 
tester application will continue to run in the background and will accumulate test 
results as normal. In this state the test application will maintain its control of the Alarm 
and Signal LEDs (  and ) and may also be able to maintain the on-screen 
simulated LEDs (this will depend on the particular system application being displayed). 
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3.2 Using the file system and the File Manager 

The ANT-5 provides an MS-DOS compatible file system with a hierarchical directory 
structure which uses internal RAM or a CompactFlash card as its storage medium.  

The File Manager utility is provided to 
allow viewing of the contents of the 
storage card. This utility will also allow 
common housekeeping operations 
such as formatting cards and copying, 
deleting and renaming files. 
To run the File Manager utility, press 
Alt + Menu and select File Manager 
from the Tools menu. To perform an 
operation on an object, highlight its 
name using the directional keys and 
then press Menu to display a list of 
valid operations.  

3.2.1 Navigating the file system 

When the user first enters the file 
system browser, and there is a 
formatted card inserted in the slot, the 
screen shown here will be displayed. 
A message will be displayed if no 
storage device is available or no card 
is inserted. 
To browse the contents of the storage 
card, move the highlight to the device 
named “card:” and press the Enter 
key or right directional key. The 
contents of the root directory of the 
card will then be displayed.  

Note 1: The user: device is the internal RAM storage. In normal circumstances the 
ANT-5 operating system copies the data stored in this area into non-volatile memory 
during its power-down sequence. Data may be lost from this device in exceptional 
circumstances when the power-down is not controlled by the operating system, for 
example if the ANT-5 is switched off by holding the Off key down for more than 6 
seconds. 

Note 2:  Do not modify or delete any of the files on the /internal: device as it may 
render the ANT-5 inoperable. 
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3.2.2 Directories 

The File Manager in… message at the top of the screen shows the current position in 
the directory structure. To display the contents of a subdirectory, position the highlight 
over the directory name and press the Enter key or right directional key. 

To move back to a higher directory, press the left directional key or position the 
highlight over the <back one> entry and press the Enter key; the contents of the 
parent directory will then be displayed. 

To create a new directory, press Menu to display the File Manager menu then select 
Create directory from the File section. 

3.2.3 Specifying a filename 

At various times the user may be required to specify a filename. Typically this will be 
for saving and retrieving data to and from the card. 

When saving a file, the directory structure is displayed and navigated in the same way 
as in the File Manager utility (See Section 3.2.2, Directories). Before saving a file in a 
directory, the directory must have already been created. 

To save a file using an existing filename, highlight the required file and press Enter. 

To save a file using a new filename position the highlight over the <new file> entry, 
press the Enter key and enter the new filename. 

3.2.4 Valid filenames 

Valid filenames can have up to 8 letters or numbers in their name. They can also 
contain a file extension of up to 3 letters, which usually indicates the type of the file. 
The extension is separated from the first part of the name by a dot. Filenames are 
always displayed in upper case characters. The following are examples of valid 
filenames: 

• ABC123 

• RESULTS1 

• TEST1.DAT 

Note: The ANT-5 does not support long filenames. If a card containing files with long 
filenames is inserted into the ANT-5, the long filenames may be lost. 
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3.2.5 Saving results 

A FIFO (First-In, First-Out) buffer is used to manage automatically saved files. Results 
from the last run test are saved as AUTO1.A5R in the user: device of the file manager 
when the  key is pressed. Only three files can be saved AUTO1, AUTO2 and 
AUTO3, consequently the next time a file is saved as AUTO1, the previous AUTO1 is 
renamed AUTO2, etc and file AUTO3 is discarded. Therefore, we recommend that 
important files are copied or renamed. 
1. Select file manager (Press Alt + Menu and select Tools > File Manager), 
2. Press enter to access the user: files 
3. Select the appropriate AUTO file 
4. Press the Menu key and select File to Copy or Rename the file. 

3.2.6 Formatting a card 

!
 

WARNING: Formatting the card will erase all data stored on it. 

To format a card, insert an appropriate card and run the File Manager utility. If the 
card has already been formatted it should appear as a device named “card:”. To 
examine the contents of the card prior to formatting, move the highlight to this device 
and press the Enter key or right directional key. 

Use the Menu key to display the File Manager menu, then 
select Format (PC) Card from the Tools section. A warning 
message will be displayed to request confirmation before the 
data stored on the card is erased. ‘Press’ the OK button to 
proceed. 

3.2.7 Refreshing the displayed file list 

The File Manager automatically 
updates the displayed file list when a 
card is inserted or removed. 
The ANT-5 can be forced to re-read 
the card contents by selecting 
Refresh from the File Manager Tools 
menu. This can be useful, for 
example, if the contents of the card 
have been changed by another 
application. 
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3.2.8 CompactFlash Cards 

CompactFlash Cards can be read using a compatible CompactFlash card reader. 
Alternatively, (where the PC’s IDE Controllers allow) files can be transferred from the 
ANT-5 to a PC, by placing the CompactFlash card into a CompactFlash card adapter, 
for example. The contents of the card can then be read using a PCMCIA (PC Card) 
compatible device. 

3.3 Transferring files to a PC environment 

3.3.1 Transferring files from the ANT-5 to a PC using the serial port 

(See also 4.7.1, Exporting data to a spreadsheet). 

The File Manager can be used to transfer data files from the ANT-5 to a PC using the 
serial port. The following example assumes that Windows HyperTerminal and the 
COM1 port are available for use on the PC: 
1. Connect an appropriate serial cable, such as K1524 or K1619, from the ANT-5 to 

the COM1 port on the PC/Laptop 
2. Switch on the ANT-5 and make a note of the Serial Port settings from the System 

menu. 
3. Run Windows HyperTerminal on the PC and choose a name for the connection. 
4. Use HyperTerminal to establish a connection by selecting Direct to Com1. 
5. When the COM1 properties appear in the HyperTerminal window, choose port 

settings to emulate those on the ANT-5 and set the flow control to Xon/Xoff. 
6. In the HyperTerminal window click on Transfer, and then Capture Text. Give the 

file a name, and click on Start. 
7. Open the ANT-5 File Manager and highlight the file to be transmitted. 
8. Press the ANT-5 Menu key and select Transmit… from the File menu. A dialog 

box will appear on the ANT-5 screen confirming the transfer and the 
HyperTerminal screen will fill with data. 

9. To stop the capture click on Transfer in the HyperTerminal window, followed by 
Capture Text and then Stop. 

Note: It is also possible to send a test pattern by selecting Send Test Pattern under 
the Serial Port item in the ANT-5 System menu. 
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3.3.2 File Transfer  

Assuming the ANT-5 is connected to 
a network, users are able to transfer 
files between the PC and an ANT-5 
using either a command line FTP 
client or via a graphical FTP with 
programs such as Internet Explorer. 
Refer to section 2.8.1 for information 
on communications configuration. 
In this example two sessions of 
Internet Explorer have been opened 
to transfer files between two ANT-5’s, 
by typing in the command ftp:// 
followed by the relevant IP addresses 
of the ANT-5. 

 

When accessing the file system remotely, be sure to change to the /user: directory. 
Do not add or retrieve files from the /internal: directory. 

Tip: Master configuration files for an ANT-5 can be simply copied to other units by 
transferring the .A5C files. 

3.4 Available online help 

The ANT-5 includes electronic documentation to facilitate testing and interpreting test 
results. All documentation is available from the Help menu. To access the Help menu, 
press Menu on the keypad. 

Help > About Select this option to view version information. 
Help > 
Glossary 

Select this option to view definitions of test results. 

Help > 
Keyboard 

Select this option to view a guide to generating symbols and 
ASCII control characters from the keyboard. 

Help > SDH 
Structure 

Select this option to view a schematic of the SDH physical layer. 

Help > SONET 
Structure 

Select this option to view a schematic of the SONET physical 
layer. 
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4. The SDH Access Tester Application 
The SDH Access Tester application has three viewing modes: Setup, Result, and 
Actions. Each viewing mode has a number of tabbed pages associated with it as 
shown in the table below. 

Note: The tabbed pages for Performance Analysis, Repetitive BERT, APS, Delay and 
Tributary Scan will only become available if the measurement is selected from the 
Measurement Selection panel. See section 4.3.1 for further details. 

Tabbed Setup pages 

 
Signal Structure page  

 
AAL-2 / AAL-5 Setup 

 
Measurement Selection  

 
ICMP Setup (Ping, Trace 
Route, Reply to Ping) 

 
Overhead Setup  

 
Measurement Timer Setup 

 Autoconfigure  
 

Performance Analysis Setup 

 
ATM setup page  

 
Tributary Scanning Setup 

 
Tabbed Results pages 

 
Results Summary page  

 
APS page 

 
Performance Analysis results  

 
Pointer Analysis page 

 
Anomalies and Defects page  

 
Round Trip Delay page 

 
Overhead Analysis page  

 
Tributary Scanning results 

 
TCM results page  

 
Sa bit sequence results
(requires PDH Mux option) 

 
Repetitive BERT page  

 
Channel Traffic Analyzer 
(CTAN) 

 
Ping  

 
IMA Monitor 

 
Reply to Ping  

 
AAL Statistics 

 
Trace Route    
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Tabbed Actions pages 

 
Injection page  

 
Pointer generator page 

 
Modify overhead bytes page  

 
TCM generator page 

Table 1 – Tabbed pages for Setup, Results, and Actions views 

Each page can be accessed by using the directional keys to highlight its page tab. 

Setup view allows the user to set up the interface and test parameters. If a test is not 
running, the settings can be easily changed by moving around the screen with the 
directional keys and selecting items with the Enter key. If a test is currently running 
the setup pages can be viewed but not changed. 

Results view allows the user to view the test results as a test is running or after it has 
been stopped.  

Some of the Results view pages are split into two halves. The left half of these pages 
are used for displaying results and the right half is used for setting the various test 
parameters. 

Note: The results of a test are always displayed with regard to the test parameters 
which were set up at the time the test was run. These may not match the current setup 
parameters if any changes have been made since the test was run. 

Actions view provides facilities for injecting anomalies and defects, and for changing 
overhead bytes and pointer values. 
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4.1 General screen layout 

The SDH Access Tester application organises the screen into the typical areas shown 
below. 

Display area

Page tabs

Function keys

On-screen 'LED' indicators
Application title bar
Status bar

 
• The top portion of the screen is used by the application to simulate LED indicators 

on-screen in order to display information which is relevant to the current setup of 
the application. See Section 4.8. The title of the current application is shown in the 
application title bar. 

• The status bar is used to display the status of the interface and the current test. 

• The display area has a number of tabbed pages which can be made active by 
selecting the tabs down the right side. The display area is used for setting up tests 
and displaying results. For some pages the display area may be split into left and 
right areas and may have multiple results pages which can be selected. 

• The six unmarked keys at the top of the keyboard, , are function keys to 
control certain features of the ANT-5. The function of each active key is identified 
by an animated button on the screen just above the actual key. 

4.1.1 Moving around the screen 

Use the directional keys for moving around active parts of the display area, 
such as buttons and list boxes, which are highlighted in turn. The page tabs 
can be highlighted by moving up and down the right side of the display 
area. 

 

Press the Enter key to operate a highlighted button or to select a 
highlighted list item. 

 

4.1.2 Status bar 

The status bar is used for displaying the status information for pattern sync, defect 
notification and anomaly/defect injection. The elapsed time of the test in hrs:min:sec 
format is shown in position k. If a test is not running, the elapsed time of the previous 
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test will be displayed. Position l shows how long the test will run. (See Section 4.3.4 to 
set the duration of the test.) 

Elapsed time

a b e f h
Status bar

c d k l Activity iconsg j
 

Rx Icons 
 The pattern sync icon (position a) displays a steady synchronised digital 

signal if the instrument is synchronised on a BERT pattern. 

   The pattern sync icon displays an animated unsynchronised digital signal 
if the instrument is unable to synchronise on a BERT pattern. This defect 
is also known as LSS (Loss of Sequence Synchronisation). 

 The pattern sync icon is blanked if no BERT pattern is present or there 
are no containers selected to carry a BERT pattern. 

 The defect detected icon (position a) flashes if any other defect condition 
is currently being detected at the selected Rx input, such as LOS. 

 The OK icon (position b) is displayed if no alarm or error conditions have 
been detected at the selected Rx input, since the beginning of the test. It 
is linked to the large OK displayed on the screen and will also be 
displayed if the results are cleared by pressing the Reset function key. As 
soon as an alarm or error condition is detected the icon will be blanked 
and the large OK displayed on the screen will be replaced by another 
results panel showing the condition detected. 

 (position c) is displayed depending on the type of performance analysis 
chosen. For example BIT will be shown if G.821 is selected. 

 Assuming the ATM option has been purchased and enabled (see Section 
6) this icon (position d) becomes animated when load ATM traffic is 
monitored at the receiver (Rx). 

Tx icons 
 The anomaly injection icon (position e) displays an animated syringe 

when anomalies are being injected. The icon is blanked when anomaly 
injection is not active. 

 The defect injection icon (position f) flashes if a defect condition is 
currently being injected. The icon is blanked when defect injection is not 
active. 

 The TCM generator icon (position f) appears when TCM generation is 
active. The icon is blanked when TCM generation is not active. 

 The pointer generator icon (position f) appears when pointer generation is 
active. The icon is blanked when pointer generation is not active. 
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 The laser warning icon (position g) is displayed with a yellow background 
when the ANT-5 laser source (Tx) is activated. The icon is greyed out 
when the laser is deactivated and is blanked if an electrical interface is 
selected. 

  These icons show if the beeper is turned on or off, (position h). Pressing 
the beeper key on the keyboard controls this function.  

 These icons (position j) show the current status of the test. The green 
light is displayed while a test is running and a red light is displayed when 
a test has been stopped. The amber light is displayed when a test is due 
to begin from a delayed start. See section 4.3.4. 

4.1.3 Function keys 

The six unmarked keys at the top of the keyboard, , are function keys to control 
certain features of the ANT-5. The function of each active key is identified by an 
animated button on the screen just above the actual key. The state of each button 
icon, whether it is shown pushed in or not, is also used to indicate current functional 
states such as Setup view or Results view. The button icons are greyed when a 
function is not available. 

Firm key Function 

 Switch to Setup view. 

Alt
 +  

Switches to the Signal Structure setup page 

 Switch to Results view. 

 Switch to Actions view. 

Alt
+  

Switches to the Results summary page 

Alt
 +  

If a test is running Reset will clear all of the counter values, 
elapsed test time and LEDs. If a test is not running Reset will 
clear the LEDs without clearing the existing test results. 

 or  Within the Signal Structure screen, copies the signal structure 
of the Tx Path to the Rx Path, and vice versa. 

 Depress the inject key injects a range of anomalies and 
defects into the transmission signal. See Section 4.4.3 for 
more details. The inject firm key appears automatically in the 
Injection page. Alternatively, users can select this firm key by 
pressing the Alt button from any other page. 

 Causes generation of a tributary unit pointer. 

 Causes generation of an administrative unit pointer. 

 Begins injection of new overhead bytes. 
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Firm key Function 
 or  These keys are used from the results page when clock offset is 

enabled. The transmitter offset can be adjusted in steps of 
0.1 ppm by pressing the required offset firm key, or offset in 
increments of 1.0 by pressing and holding down the firm key. 

 or  When anomalies or defects are displayed as graphs, the 
 and  keys can be used to adjust the units of 

time along the x-axis of the graph. 

 or  When overhead analysis/injection results are displayed, the 
ASCII and HEX keys can be used to switch between the alpha 
and numeric views. 

 or  Start a test, or Stop the test if one is running. (Once a test has 
been stopped, up to three files are automatically saved on the 
user: device, see 3.2.5 for further details). 

Table 2 – Function key. 

Some examples of function key positions are shown below: 

 

 

 (Press Alt to display these keys.) 

4.2 AutoConfigure 

When you use the Automatic Configuration feature, the unit analyzes the signal and 
configures itself based on the test interface (SDH, SONET, or PDH), mapping 
structure, and payload (if applicable). When Auto Configuring to a 2M channel 
containing 64k sub-channels, the ANT-5 assumes live traffic for the 2M channel and 
will not determine a pattern. Auto Configure functions similarly with a 1.5M channel 
containing 64k sub-channels. In both instances, the unit will display an “uncertain” 
result. To analyze a 64k channel, you must configure the ANT-5 manually 

The AutoConfigure facility can be accessed by performing the following procedure. 
1. Connect the interface cables. 
2. Press the Alt+Tx/Rx firm key to display the signal structure page. 
3. Press the Alt+Autocfg firm key. 
4. Select the input level: ITU/High or PMP/Low. 
5. Press the Autocfg firm key. 
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A message appears that describes 
the results of the autoconfigure 
operation. The actual settings appear 
in the RX section of the structure 
setup page. 
After initiating the autoconfigure utility, 

the autoconfigure tab  appears 
along with other setup tabs after 
pressing the Setup firm key. 

 

4.3 Setup pages 

The SDH Access Tester application uses a range of tabbed setup pages to set the 
interface and test parameters before running a test. The settings can be easily 
changed by moving around the screen with the directional keys and selecting items 
with the Enter key. If a test is running, some parameters on the setup pages can be 
viewed but not changed and these will be greyed to indicate that they are disabled. 

When making changes to the setup, any value selected for a parameter (by pressing 
the Enter key for example), becomes effective immediately unless it is not a valid 
value. In this case the previous value will be retained or a substitute value used. 

Note: Whether a test is running or not, the transmitter will start to transmit 
continuously as soon as a valid configuration is entered. The receiver will look for and 
attempt to recognise a valid signal on its Rx input in readiness for the Start key being 
pressed. When a test is not running, the LEDs and Rx icons will continuously indicate 
errors and alarms but any other results displayed will be the results of a previous test. 

4.3.1 Signal Structure setup page 

The Signal Structure setup page 
allows the configuration of both the Tx 
and Rx to be set up for the particular 
device or system under test (DUT). 

 

The settings for each element of the signal structure can be changed by moving 
around the structure diagram using the directional keys and selecting items with the 
Enter key. A window showing the available parameters for that element will then be 
displayed. 
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Hierarchy

Interface

Interface

Hierarchy

Virtual
Container

Pattern

PDH

PDH
Channel

Pattern

Virtual
Container

Channel

Timeslot

Timeslot Termination
75ohm

 

The procedure for setting the Rx elements of the test structure is very similar to the 
setting of the Tx elements except for the Interface Setup Rx window, which has a 
different set of parameters. 

The list of available parameters for each part of the structure may vary depending 
upon the configuration selected in the other elements. For example, if a PDH interface 
is selected, the Virtual Container setup dialog box will not appear, since this box is 
only applicable to SDH. 

The signal structure always appears with a test pattern source and test pattern 
detector. If the incoming signal is expected to contain network traffic, the Traffic 
pattern may be selected to disable the receiver’s pattern detection process and the 
reporting of LSS defects. 

When setting up the various parts of the signal structure for the ANT-5, it is advisable 
to make changes to each element of the structure in the order that they are referred to 
in this chapter. 

4.3.1.1 Hierarchy Setup Tx 

Selecting the Hierarchy element for the 
transmit path opens the Hierarchy Setup Tx 
panel, allowing either SDH or PDH framing 
types to be selected. 
If PDH is selected, the PDH line rate is 
determined by the Bit Rate selected in the 
PDH Setup screen. 

 

Note 1: The optical Rate for STM-1, STM-4 and STM-16 are also selectable if the 
options have been purchased and enabled. 

Note 2: AU-3 Mapping will also become selectable if the option has been purchased 
and enabled. 
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Note 3: The Sonet Hierarchy Type is available if the SONET option has been 
purchased and enabled. 

!
 

Remember: Connect an external optical attenuator to the optical Rx port as care 
must be taken not to connect a long-haul (high power) transmitter directly to the 
receiver, since this can overload or even damage some receiver modules. 

4.3.1.2 Interface Setup Tx 

Selecting the Interface element for the 
transmit path opens the Interface Setup Tx 
panel, allowing electrical and optical options 
to be selected. The fields appearing in this 
panel depend on the defined hierarchy.   

 
Clock Source The transmitter Clock Source can be set to Internal, From Rx, or 

External, with selections of Data 2048kbits/s, Clock 2MHz, Data 
1544kbits/s, or Clock 1.5MHz. 
For the Internal setting, the clock for the transmitter is derived 
from the internal 2048 kbit/s clock. For the From Rx setting, the 
clock for the transmitter is derived from the Rx connector.  
When selecting settings for the external clock, the clock for the 
transmitter is synchronised to the signal on the Ext. Clk 
connector. 

Clock Offset The frequency offset of the received signal is the difference 
between the received frequency and the expected frequency. All 
network equipment (NE) can tolerate a certain amount of offset. 
However, if the limits are exceeded a NE will fail to synchronise to 
the received signal which will result in network errors. 
Skewing the frequency is a standard test during installation to 
ensure that an installed unit can tolerate the frequency offsets 
occurring within the network. 
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 The Clock Offset is only available when the Clock Source is set 
to Internal. With the Clock Offset box checked a value can be 
entered for the offset, from –100 to +100. However, once a test 
has started the clock offset can only be changed using the 
associated firm keys from the Results page. See Section 4.4.1 for 
further details. 

 
Note: If the signal structure is changed the parameters for clock 
offset will need to be re-established. 

Output The output interface can be set to either Optical or Electrical. If 
the ANT-5 is equipped with an optical interface, both electrical and 
optical options will be available. 
If a PDH structure has been selected in the Hierarchy setup, the 
optical options will be disabled. If an SDH structure has been 
selected and the ANT-5 is equipped with an optical interface, both 
electrical and optical options will be available. 
If the Optical interface is selected, the state of the Laser On 
checkbox can be toggled, and the Wavelength can be set to 
either 1310 nm or 1550 nm, depending on which optical options 
have been fitted to the instrument. 
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Line Code The Line Code setting automatically defaults to the setting 
appropriate to the interface type, as listed in the following table. 
You can change the line code for the E1 and DS1 rates. 

Interface Line Code 
SDH Optical NRZ 

STM-1 Electrical CMI 

STM-0 Electrical B3ZS, HDB3 

E4 CMI 

DS3 B3ZS 

E3 HDB3 

E1 HDB3, AMI 

DS1  B8ZS, AMI  
Wavelength The peak-to-peak length of the laser signal. 
Laser On Indicates if the unit transmits the signal with its internal laser. 
Line Type If the transmitting hierarchy type is PDH, and if the PDH High Rate 

is 2M (see illustration in section 4.3.1.5), you can set the line type 
to Balanced or Unbalanced. 

4.3.1.3 Virtual Container Setup Tx 

Selecting the Virtual Container element for the 
transmit path opens the Virtual Container 
Setup Tx panel, allowing SDH mapping options 
to be selected. 
This element will not be available if a PDH 
interface has been selected. 
Bulk should be selected as the Tributary if 
bulk testing of the virtual container is required. 
The test pattern will then be injected across the 
whole of the Virtual Container. 

 

If testing within a PDH hierarchy is required, the PDH tributary should be selected. 
The test pattern will then be injected into the selected SDH virtual container with the 
selected PDH parameters. 

Note: VC11/TU11 and VC11/TU12 will also become selectable if the 
AU-3/VC11/SONET VT mappings option has been purchased and enabled. 
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4.3.1.4 Channel Setup Tx 

Selecting the Channel element for the 
transmitter side opens the Channel Setup Tx 
panel, allowing selection of the SDH tributary 
channel which is to be tested. 
This element will not be available if a PDH 
interface has been selected. 
The Tx channel is selected by entering the 
discrete TUG and TU numbers for the channel 
in the appropriate window. The availability of 
different TUG-3, TUG-2 and TU-12 groups for 
selection is dependent upon the SDH Virtual 
Container. 

 

For example, if a VC-3 has been selected for a test, then only the TUG-3 parameter 
can be adjusted, enabling selection of which TUG-3 within the VC-4 will carry the 
VC-3 payload. Alternatively, if a VC-12 has been selected for a test, then the TUG-3, 
TUG-2 and TU-12 can all be adjusted, enabling selection of which TU-12 will carry the 
VC-12 payload. 

As an alternative to selecting the discrete TUG and TU numbers, the corresponding 
number of the Virtual Container can be selected. This is of benefit when setting up 
VC-12s or other complicated mappings. On entering a VC number, the TUG and TU 
numbers will automatically change to match the new VC. The table in Section 12.4, 
SDH Tributary Numbering, gives the relationship between the VC numbers and TUG 
numbers for the Tributary and Timeslot (ITU-T) numbering methods. 

4.3.1.5 PDH Setup Tx 

Selecting the PDH element for the transmitter 
side opens the PDH Setup Tx panel, allowing 
selection of the PDH parameters for the test 
signal. 
The test signal is either injected into the SDH 
Virtual Container if an SDH line interface has 
been selected, or is passed directly to the PDH 
line interface if a PDH line interface has been 
selected.  

If Bulk has been selected as the Tributary in the SDH Virtual Container then the PDH 
Setup Tx panel will not be available. 

Note: If an SDH line interface has been selected, only bit rates and framing types 
appropriate for the SDH configuration will be displayed as options within this panel. 
PDH Low Rate is only applicable if Nx64 testing is required, See Section 4.4.12. 
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4.3.1.6 Pattern Setup Tx 

Selecting the Patterns element for the transmit 
path opens the Pattern Setup Tx panel, 
allowing selection of the test pattern which will 
be inserted into the SDH Tx channel or PDH 
interface. 
One pattern from a range of pattern types can 
be selected, including the digital word pattern, 
DW. If this is selected the content of the word 
can be set up in the 16-Bit Word box which 
appears below the Pattern Type selector. 
Inverted patterns are also available and are 
indicated by an ‘I’ at the beginning of the 
pattern name, for example IPRBS23 is the 
inverted form of the 2 23-1 pattern, PRBS23. 

 

Note: The pattern element will be greyed out if the round trip delay measurement has 
been activated. See section 4.4.11, Delay, for further information. 

4.3.1.7 Hierarchy Setup Rx 

The ANT-5 supports inline monitor, terminated, and intrusive thru mode testing for 
SDH, SONET, T1, and E1 interfaces. Inline monitor testing allows technicians to 
monitor data without disturbing live voice or data traffic. Because inline monitor testing 
does not disrupt the transmission of live traffic, it is more suitable for routine 
maintenance than terminated testing. (This requires prior break down of the line to 
insert the ANT-5 within the circuit.) Another advantage of inline monitor testing is that 
it indicates performance under actual operating conditions. Its primary disadvantage is 
that measurements may not be as precise as those available through terminated 
testing. 

Inline monitor testing is generally performed for the following purposes: 

• Routine maintenance—Using in-service monitoring for routine maintenance can 
show degrading performance before it disrupts normal operation. 

• Fault isolation—In-service monitoring can aid in localising problems and minimising 
circuit downtime. By monitoring the circuit at various points, technicians can 
analyse the results and discover where problems are originating. 

When testing in inline monitor mode, the 
signal structure page changes. You can 
modify the structure of the received signal, 
and only the interface of the transmitted 
signal. 
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Terminated testing requires that live traffic be removed from the circuit before testing 
can begin. This frees the circuit for advanced testing techniques such as injecting test 
patterns or manipulating bit values. By simultaneously generating and analysing the 
received data for errors, the ANT 5 can analyse the performance of the circuit in both 
directions. 

When testing in terminated mode, the signal structure page appears similar to that on 
page Error! Bookmark not defined..  

Selecting the Hierarchy element for the receive 
path opens the Hierarchy Setup Rx panel, 
allowing either SDH, SONET, or PDH framing 
types to be selected. 
If PDH is selected in the Hierarchy Type field, 
the line rate is determined by the Bit Rate 
selected in the PDH Setup screen. 

 

Testing in intrusive thru mode allows the technician to monitor live traffic and modify 
framing information, manipulate overhead bytes, and insert errors as the traffic passes 
thru the ANT-5. Anomalies and defects that would prevent the traffic from passing 
through the unit can not be inserted in thru mode. 

The following table lists the available hierarchy types, associated rates, and ports 
used for physical connections. 

Hierarchy Rate Connector 
PDH E4 STM-1, E4, DS3, E3 BNC 
 DS3 STM-1, E4, DS3, E3 BNC 
 E3 STM-1, E4, DS3, E3 BNC 
 E1 E1 BNC or E1 RJ-45 
 T1 T1 Bantam 
SDH STM-0 Electrical STM-1, E4, DS3, E3 BNC 
 STM-1 Electrical STM-1, E4, DS3, E3 BNC 
 STM-1 Optical STM-n Optical 
 STM-4 Optical STM-n Optical 
 STM-16 Optical STM-n Optical 
 STM-1 NRZ STM-n NRZ 
 STM-4 NRZ STM-n NRZ 
 STM-16 NRZ STM-n NRZ 
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Hierarchy Rate Connector 
SONET STS-3 Electrical STM-1, E4, DS3, E3 BNC 
 OC-3 Optical STM-n Optical 
 OC-12 Optical STM-n Optical 
 OC-48 Optical STM-n Optical 
 OC-3 NRZ STM-n NRZ 
 OC-12 NRZ STM-n NRZ 
 OC-48 NRZ STM-n NRZ 

See Section 1.4, Physical layout and connectors, for the locations of connectors on 
the ANT-5. 

The signal structure always appears with a test pattern source and test pattern 
detector. The user may wish to disregard the BER features, whilst only monitoring 
SDH or PDH defects, if required. 

Note 1: The optical Rate for STM-1, STM-4 and STM-16 are also selectable if the 
options have been purchased and enabled. 

Note 2 AU-3 Mapping will also become selectable if the option has been purchased 
and enabled. 

Note 3: The SONET Hierarchy Type is available if the SONET option has been 
purchased and enabled. 

4.3.1.8 Interface Setup Rx 

Selecting the Interface element for the receive 
path opens the Interface Setup Rx panel, 
allowing electrical and optical options to be 
selected.  

 
Input The input interface can be set to either Optical or Electrical. If a 

PDH structure has been selected in the Hierarchy setup, the optical 
options will be disabled. If an SDH or SONET structure has been 
selected and the ANT-5 is equipped with an optical interface, both 
electrical and optical options will be available. 
If the Optical interface is selected, the receiver interface will detect 
any optical signal within the specified receiver wavelength range 
(1100 nm to 1580 nm). 
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Sensitivity If the Electrical interface is selected, the sensitivity can be set for 
ITU-T, PMP (Protected Monitor Point) or HIGH connections. The 
PMP setting includes appropriate linear gain to compensate for the 
attenuation at the protected monitor point. The electrical interface will 
be terminated in either 75Ω (BNC) or 120Ω (RJ-48). See section 
9.4.3 for further information. 

Pulse Shape HIGH or DSX can be selected as the pulse shape and is used when 
testing PDH tributaries with a bit rate of 45M 
Note: A HIGH pulse shape should not be confused with high 
impedance. 

Line Type If the receiving hierarchy type is PDH, and if the PDH High Rate is 
2M (see illustration in section 4.3.1.11), you can set the line type to 
Balanced or Unbalanced. 

Termination If the receiving and transmitting hierarchy types are PDH, and if the 
PDH High Rate is 2M (see illustration in section 4.3.1.11), then the 
Termination field becomes available. Select Hi-Z for a high-
impedance monitor test, or Terminated for a terminated test. 

4.3.1.9 Virtual Container Setup Rx 

Selecting the Virtual Container element for the 
receive path opens the Virtual Container 
Setup Rx panel, allowing SDH mapping 
options to be selected. 
This element will not be available if a PDH 
interface has been selected. 
Bulk should be selected as the Tributary if 
bulk testing of the virtual container is required. 
The test pattern will then be injected across the 
whole of the Virtual Container. 

 

If testing within a PDH hierarchy is required, the PDH tributary should be selected. 
The test pattern will then be injected into the selected SDH virtual container with the 
selected PDH parameters. 

Note: VC11/TU11 and VC11/TU12 will also become selectable if the option has been 
purchased and enabled. 
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4.3.1.10 Channel Setup Rx 

Selecting the Channel element for the receiver 
side opens the Channel Setup Rx panel, 
allowing selection of the SDH tributary channel 
which is to be tested. 
This element will not be available if a PDH 
interface has been selected. 

 

The Rx channel is selected by entering the discrete TUG and TU numbers for the 
channel in the appropriate window. See Section 4.3.1.4, Channel Setup Tx, for 
further details. 

4.3.1.11 PDH Setup Rx 

Selecting the PDH element for the receiver side 
opens the PDH Setup Rx panel, allowing 
selection of the PDH parameters for the test 
signal. 
The test signal is either detected from the SDH 
Virtual Container if an SDH line interface has 
been selected, or is detected directly from the 
PDH line interface if a PDH line interface has 
been selected. 

 

Note: If an SDH line interface has been selected, only bit rates and framing types 
appropriate for the SDH configuration will be displayed as options within this panel. 
PDH Low Rate is only applicable if Nx64 testing is required. See Section 4.4.12 for 
details.  

4.3.1.12 Pattern Setup Rx 

Selecting the Patterns element for the receive 
path opens the Pattern Setup Rx panel, 
allowing selection of the test pattern which will 
be extracted from the SDH Rx channel or PDH 
interface. 
 

 

One pattern from a range of pattern types can be selected, including the digital word 
pattern, DW. If this is selected the content of the word can be set up in the 16-Bit 
Word box which appears below the Pattern Type selector. Inverted patterns are also 
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available and are indicated by an ‘I’ at the beginning of the pattern name, for example 
IPRBS23 is the inverted form of the 2 23-1 pattern, PRBS23. 

The Traffic pattern should be selected if the incoming signal is expected to contain 
network traffic. Selecting this option effectively disables the pattern detection process 
and the reporting of LSS defects. 

4.3.1.13 Symmetrical Tx and Rx Settings 

Where the system under test is symmetrical, and the Tx and Rx structures are 
required to be identical, time can be saved by setting up either the Tx or the Rx 
structure, and then pressing either the  or  keys as appropriate. The 
structure will be copied from Tx to Rx, or vice versa, as selected. 

The Tx and Rx structure can also be set up independently, so that, for example, the 
Tx can be sending a PRBS of 215-1 in a VC-12 carried within an optical STM-1, whilst 
the Rx can be expecting to receive a PRBS of 215-1 in a 2 Mbit/s PDH signal. 

If the structure has been set up 
independently, as in this example; the 
mappings and bit rates are 
automatically copied. This feature has 
been designed to ensure the user has 
selected the appropriate mapping or 
rate for SDH/SONET/PDH operation. 
 

 

Generally, always edit the highest configuration, in this example STM-1 on the Tx 
takes priority over PDH on the Rx. Therefore, to change the PDH rate to 140M select 
the Virtual Container Setup Tx panel as highlighted in the graphic. Edit the VC 
Mapping to VC4, you will then notice the associated rate for the PDH Rx has changed 
to 140M. 

Note: Previous mixed mode configurations saved prior to software version 08.00 will 
no longer be valid. 
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4.3.2 Measurement Selection 

A Measurement Selection page has 
been included to ease special test 
mode selection, for example, a 
tributary scan or a delay 
measurement. Each measurement is 
mutually exclusive.  
 

 

When a special measurement mode is selected, the corresponding results page will 
be displayed by selecting the Results tab. In some cases (for example, performance 
analysis or tributary scan) a corresponding Setup page will also be available. 
Alternatively if no setup is required, check the required measurement and press the 
Start firm key to view the appropriate results page. Refer to the relevant sections (as 
listed below) for a description of the test. 

Feature Section 
Performance Analysis Setup 4.3.5 
Capturing Values for K1 and K2 Bytes 4.4.5.3 
Performance Analysis Results 4.4.3 
Repetitive BERT 4.4.8 
Automatic Protection Switching 4.4.9 
Delay 4.4.11 
VC12 Tributary Scanning Setup 4.3.6 
VC12 Tributary Scanning Results 4.4.7 

Note: To select Tributary Scan ensure VC12 is selected as the Virtual Container for 
the Transmitter (Tx) and the Receiver (Rx). (See Sections 4.3.1.3 and 4.3.1.9). 

4.3.3 Overhead Setup 

The Overhead Setup page has five separate sub-pages which can be viewed by 
selecting the appropriate entry in the View menu at the top of each page. 
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4.3.3.1 Transmitted Trace Identifiers 

Selecting Tx Trace Identifier allows 
the transmitted Trace Identifiers (TI) 
to be set up. 
Three trace identifiers are transmitted, 
the Regenerator Section TI (J0), the 
High Path TI (J1), and the Low Path 
TI (J2). 
The RS-TI can be set to 1 byte or 16 
bytes in length. The HP-TI and LP-TI 
can be set to 16 bytes or 64 bytes in 
length.  

 

If the RS-TI is set to 1 byte, its 
contents are entered in the form of 
two hexadecimal digits. During this 
entry, the function keys are 
temporarily assigned the alphabetical 
values ‘A’ to ‘F’. The two hexadecimal 
digits can be entered by using the 
keyboard for the decimal numbers 
and the function keys for the alpha 
characters. 

 

4.3.3.2 Trace Identifiers 

To set up the trace identifiers, select 
the TIM Setup view. Three trace 
identifiers can be optionally 
monitored, by checking the box 
alongside each trace identifier field 
(RS-TIM, HP-TIM or LP-TIM). If the 
received values differ from the values 
preset within this page, and the 
respective box is checked, a defect 
alarm is raised and noted within the 
Results pages. 
The RS-TIM can be set to 1 byte or 
16 bytes in length. The HP-TIM and 
LP-TIM can be set to 16 bytes or 64 
bytes in length.  
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If the RS-TIM is set to 1 byte, its 
contents are entered in the form of 
two hexadecimal digits. During this 
entry, the function keys are 
temporarily assigned the alphabetical 
values ‘A’ to ‘F’. The two hexadecimal 
digits can be entered by using the 
keyboard for the decimal numbers 
and the function keys for the alpha 
characters. 

 

If required the following control characters can be inserted into the trace label strings 
for expected and transmitted bytes. Alphanumeric characters can be entered using the 
keyboard keys.  

 

NUL Nul BS Backspace 

TAB Tabulation LF Line Feed 

CR Carriage Return DEL Delete 

4.3.3.3 Path Labels 

To set up the path labels, select the 
PLM Setup view. Two path labels can 
be optionally monitored, by checking 
the box alongside each path label 
field. If the received values differ from 
the values preset within this page, 
and the respective box is checked, a 
defect alarm is raised and noted 
within the Results pages. 
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4.3.3.4 Tandem Connection Monitoring 

Tandem connection monitoring (TCM) 
allows the comparative performance 
of path segments to be monitored with 
the aid of the N bytes in the path 
overhead. Select the TCM view to set 
up tandem connection monitoring. 
The received HP and/or LP paths can 
be monitored by selecting the HP and 
LP check boxes as required. The 
appropriate paths will then be 
activated on the TCM results page. If 
neither box is selected, the TCM 
results page will not be available. See 
Section 4.4.4.3, Anomaly Count. 

 

4.3.3.5 AU Pointer Value 

The Expected AU Pointer H1 byte is 
continually monitored, and checked 
against the received value. If the 
received AU pointer differs from the 
expected value a defect alarm is 
generated. The user can adjust the 
transmitted value of the SS bits within 
the H1 byte. Selecting the value ‘XX’ 
from with the Expected drop-down 
menu disables this monitoring.  
10 = SDH signal, 00 = SONET signal.  

Note: The transmitted and expected frames become visible if SDH or SONET are 
selected as the hierarchy type for Tx and Rx. 



 The SDH Access Tester Application 

  ANT-5 Page 63 

4.3.4 Measurement Timer Setup 

The Measurement Timer Setup 
page can be used to set up a test to 
run with a fixed duration and/or a 
delayed start at some time in the 
future which is set by the user. 
To run a test with a delayed start, set 
up all parameters as for a normal test 
and run a short test to verify the 
settings. Then set the timer to the 
required start time and press the Start 
key. The instrument will then go into a 
standby mode until the programmed 
start time, when it will begin to run a 
test and count results in the normal 
way. During the standby period the 
LEDs and status icons will be active 
to indicate the status of the line. 

 

 

Test start The timer can be set up for Manual start or Delayed start. 
Start time / date If Delayed start is selected, further entry fields can be used for 

setting the Start time and Start date. These can be used to enter 
any time and date in the future. 

Duration The test can be set to run for a specified Duration from 1 second 
up to 99 days. The time selected will be shown on the status bar. 

Notes: The Stop key will always be available to stop tests manually, regardless of the 
Timer settings. The time and date can be set in the Time & Date section of the 
System menu. 

4.3.5 Performance Analysis Setup 

Note: The Performance Analysis setup tab will become available if selected from the 
Measurement Selection page. See Section 4.3.1 for further details. 
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The Performance Analysis setup 
page is used to determine how the 
performance of a system will be 
measured and recorded by the 
instrument. A wide range of options 
are available; see Appendix E – 
Performance Analysis Options for a 
list of the options with additional 
details of the measurement method 
for each option. The setup page has 
two main parameters from which to 
choose the option – Analysis and 
Hierarchy. 

 

For each analysis type, a set of hierarchies are available, which are dependent upon 
the Analysis type selected. Some of these are only applicable to SDH, and will be 
greyed-out in the list of options if a PDH Rx interface is selected. 

For each selection of Analysis and Hierarchy, selecting the Default button restores 
the default settings to the available parameters. 

Allocation allows a percentage of the 
required performance for an HRX 
(Hypothetical Reference Connection) 
to be allocated to the current test. 
This allocation is typically 10-20% for 
Access Networks. 
SES Threshold allows setting of the 
threshold for Severely Errored 
Seconds, which in G.826 is said to be 
30% of the number of blocks in one 
second.  

UAS Limit allows setting of the threshold for Unavailable Seconds, in G.826 said to 
be 10 consecutive seconds of SES. This can be disabled by clearing the adjacent 
checkbox. 

4.3.6 VC12 Tributary Scanning Setup 

Note: The Tributary Scan setup tab will become available if selected from the 
Measurement Selection page. See Section 4.3.1 for further details. 

The ability to switch tributary signals without fully de-multiplexing and re-multiplexing 
the SDH signal is a very important feature of SDH. Using either an add/drop (ADM) or 
cross-connect (DXC), networks can be re-configured to cater for network changes. 

When implementing these changes it is important to verify the routing configuration of 
the network element prior to switching it onto line traffic. This can involve testing each 
VC12 tributary in an STM-4 – possibly 252 tributaries. 
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The ANT-5 is able to automatically scan individual or multiple tributaries to verify the 
routing and error free operation. A pass/fail indication is given for each VC12 tested. 

The tributary scanning tab will only 
become available when VC12 in the 
Virtual Container panel for Tx and 
Rx are selected. Starting any test by 
checking the Tributary Scan Setup 
box, will scan the required tributaries. 
In this example, tributaries 30 to 39 
will be scanned. 
The three Selection Methods that 
can be selected are: 
• All channels 

• Specify From/To Channels 

• Specify TUG-3’s 

 

Users can select Failed, Passed or All from the View field. In these examples of the 
user interface all Failed tributaries will be listed in the tributary scan results page. See 
Section 4.4.7, VC12 Tributary Scanning Results. 

The following example shows 
tributaries 30-63 in channel 1 will be 
scanned, followed by 1-63 in 
channel 2, 1–63 in channel 3 and 
1-39 in channel 4. For details of 
tributary numbering refer to section 
12.4. 

Note: Channels will be scanned by 
tributary rather than ITU-T number 
order.  

This example will validate the 
tributaries within the second TUG-3 
structure, for each of the STM-4 
channels, (assuming the STM-4 
option is installed). 

Note: See Section 4.4.7, VC12 
Tributary Scanning Results. 
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4.4 Results Pages 

The results screens are selected by pressing the Results function key. This displays a 
range of tabbed pages, similar to the setup pages. Some of the results pages use a 
split screen layout, with the large OK in the left half of the screen, and other details of 
the test in the right half of the screen. Other results pages use the whole screen and 
may have multiple pages which can be selected from the main screen. 

4.4.1 Results Summary 

The first tabbed page displays a 
summary of test results. 
The left half of the page displays the 
green large OK as long as there are 
no defects or anomalies recorded. If 
any defects or anomalies occur during 
a test, the large OK disappears and is 
replaced by a list of continually 
updated defects and anomalies that 
have been detected by the instrument 
during the test.  

The right side of the page displays summary information about the detected signal.  

Note: Assuming the previous test was successful, the large OK will be greyed out 
whilst the current test is being configured. 

4.4.2 Clock Offset results 

Once the test has started the ANT-5 samples the received signal from the network 
element then calculates and displays the result of the frequency offset. The ANT-5 
displays the Rx offset to check a network element is transmitting correctly.  

The External Clock Offset result and Delta (Rx - Ext) results can be used to verify that 
the receive signal is within tolerance of the network’s common clock.  The External 
connector is always active and can be hooked up to a network clock using four 
different formats: Data 2048kbit/s, Clock 2MHz, Data 1544kbit/s, or Clock 1.5MHz 
(specified on the Interface Setup Tx page).  The Delta (Rx - Ext) result shows the 
difference between the received signal and the network clock. 

The transmitter offset can be adjusted in steps of 0.1 ppm by pressing the required 
offset firm key, or offset in increments of 1.0 by pressing and holding down the 
appropriate firm key. The initial value is set in the Interface Setup Tx panel. You can 
select a value between -100.0 and 100.0 ppm. 
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This is the Rx offset (in ppm)
of the 140Mbit tributary
carried in the VC4 being
tested

These are the Tx and Rx
offsets (in ppm) for the Line
Rate, for example
155.520Mbit/s  

Note: The offset firm keys will be greyed out when the value reaches the end of its 
range. 

The Defect/Anomaly list contains the 
total number of seconds during which 
each defect has been detected and 
the total count of each anomaly which 
has occurred. 
The defects and anomalies are listed 
in order of importance and priority. 
For further details, see Appendix D – 
SDH, SONET, and PDH information.

 

4.4.3 Performance Analysis Results 

Note: The Performance Analysis results tab will become available if selected from 
the Measurement Selection page. See Section 4.3.1 for further details. 

The Performance Analysis results page enables the user to view the performance of 
the device or system under test according to a range of standards. The standard 
applied is selected in the Performance Analysis Setup page – see Section 4.3.5. 

Note: The Performance Analysis results of any test are only valid in the context of 
the setup which was used at the time that the test was run and the results were 
recorded. It is not valid to use the Performance Analysis setup page to select a 
different Analysis or Hierarchy type in order to view existing results without running a 
new test. 
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4.4.3.1 Performance Analysis results display 

Performance analysis is available for 
a wide range of standards; see 
Appendix E – Performance 
Analysis Options for a list of the 
options with additional details of the 
measurement method for each option. 
A separate analysis display is 
available for each type of analysis that 
can be selected, prior to running a 
test. This screen displays the Analysis 
standard and selected Hierarchy, and 
will list all relevant results parameters, 
in both absolute number of seconds 
and also as a percentage of the total 
test duration. 

 

A verdict of the overall result of the 
test will be displayed, with either pass, 
fail, or uncertain presented as a green 
tick, red cross or yellow question 
mark. The uncertain result is part of 
the M.2100 analysis and should be 
followed by a further 7 day test. 

 

4.4.4 Anomalies and Defects results 

4.4.4.1 Defect Panel 

The second tabbed page displays 
three different views of the SDH 
anomalies and defects, and also PDH 
errors and alarms, occurring during a 
test. Each view can be displayed by 
selecting them from the drop-down 
view menu at the top of the page. 
The Defect Panel view lists all SDH 
and PDH events in order of group 
within the SDH structure and/or PDH 
payload, and continually updates and 
displays active events in red. 
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Note: Defect panel LED’s turn yellow during a test to show historic alarms, that is, 
defects that have been raised during a test but are not currently active. To reset the 
LEDS press Alt and Menu and select System >LEDs >Reset LEDs. 

4.4.4.2 Event Log 

The Event Log view lists all SDH and 
PDH events in time order as they 
occur during a test, including start-
time, stop-time, and duration of the 
defect or total anomalies per second. 

 

4.4.4.3 Anomaly Count 

The Anomaly Count view lists all 
SDH & PDH anomalies in hierarchical 
order which are relevant to the current 
signal structure. The number of 
anomalies occurring during a test is 
counted for each anomaly type, and 
the ratio of each anomaly within the 
elapsed period of test is displayed. 

 

4.4.4.4 Graphs 

The Graph view displays a graphical 
timeline representation of any SDH 
anomalies or defects that have been 
detected during a test. The anomaly 
or defect occurrences are plotted as a 
set of horizontal bars against a time 
axis divided into intervals of one day, 
hour, minute or second. A bar is 
displayed to indicate that an event 
was detected during that time interval. 

 

The time scale is shown under the chart, and can be set to a resolution of 60 days, 
hours, minutes or seconds by pressing the  and  keys. Vertical columns 
show sub-divisions of 10 time units. The horizontal scroll bar can be used to scroll in 
steps of 10 or 60 time units, as described in the example below. 
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The list of anomalies or defects is shown to the left of the chart and can also be 
scrolled vertically if required. 

A detailed zoom feature is also available in the Anomalies Graph. This allows error 
rates to be shown down to one-second resolution, as shown in the example below. 

Example: Using the detailed zoom feature in the Anomalies Graph 
1. Select the Anomalies graph. 

2. Use the directional keys to highlight 
the timeline section. 

3. Press the Enter key to activate the 
timeline section; in this state the scroll 
bar will be highlighted. 

4. Press the  and  keys to 
select an appropriate time scale. 

5. Use the left/right directional keys to 
scroll the graph horizontally in steps of 
10 time units. For faster scrolling hold 
the Alt key down to increase the step 
size to 60 time units. 
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6. Press the Esc key to deactivate the 
timeline section. 

7. Use the directional keys to highlight 
the anomalies list. 

8. Press the Enter key to activate the 
anomalies list. In this initial state there 
will not be a selected item but one 
anomaly will be highlighted. The 
vertical scroll bar may be active if 
there are further items not displayed. 

9. Use the up/down keys to navigate the 
list and press the Enter key again to 
select items for detailed viewing. A 
histogram will be displayed under the 
timeline as shown. Total anomalies 
during each interval (second, minute, 
hour, or day) will be shown by order of 
magnitude. For example, a bar of 
height 100 represents 100 to 999 
counts. 

10. Press the Esc key to deactivate the list section. Use the directional keys to move 
to another part of the screen. 

4.4.5 Overhead Analysis 

The SDH and SONET overhead byte structures can be displayed for either transmit or 
receive paths by selecting the tab for Overhead Analysis/Injection. 
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4.4.5.1 Interpreter View 

In Interpreter View, a message 
appears that describes the overhead 
bytes detected in the received signal.  
To display the Interpreter View, select 
Interpreter from the middle list box. 
The interpreter displays different 
messages depending on the selected 
architecture: Linear (G.783) or Ring 
(G.841). 
The messages can be displayed and 
scrolled using the method described 
below: 

 

1. Use the directional keys to highlight the message section. 
2. Press the Enter key to activate the message section; in this state the scroll bar will 

be highlighted as shown. 
3. Use the directional keys to scroll vertically through the frame. 
4. Press the Esc key to deactivate the list section. Use the directional keys to move 

to another part of the screen. 
5. Toggle the Hex/ASCII button to modify the display of numerical values. 

Note: Bytes not used in the current test will be greyed out. 

J0 Trace Identifier  K2 APS Control 

J1 HP Path Indicator  S1 Sync Status 

J1 LP Path Indicator  V5 Error Monitor 

J2 Path Indicator  C2 HP Container Format 

K1 APS Control  C2 LP Container Format 

Table 3 – Overhead bytes which can be displayed in Interpreter View 
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4.4.5.2 Analysis View 

In Analysis View, a pair of tables 
representing the complete contents of 
the overhead structure is displayed.  
To display the Analysis View, select 
Analysis from the middle list box. 
The values displayed do not depend 
on the selected architecture: Linear 
(G.783) or Ring (G.841). 
If the Rate is set to STM-4 or STM-16, 
a numerical entry box will be available 
to select the channel. 
The received section and path 
overhead bytes (SOH & POH) are 
displayed, and are continually 
updated every second. 

 

Byte values are shown as follows: 

Hex value The hexadecimal value of the received or transmitted byte. 
‘—’ ‘—’ appears to indicate bytes for which a value cannot be determined. 
‘TI’ ‘TI’ appears to indicate bytes for which a correct trace identifier value 

has been recognised. 

The POH table is displayed on the right of the window, and its contents will depend 
upon the signal structure that has been selected. 

The value of individual received overhead bytes may be examined in detail using the 
Overhead Zoom feature.  

To zoom in on a particular overhead byte, select 
the appropriate table using the directional keys and 
press the Enter key; individual bytes can then be 
selected using the directional keys. When a byte is 
selected and the Enter key is pressed, the 
Overhead Zoom - Analysis window will appear 
with the details of that byte. 

 
Where an overhead byte is used for a special 
purpose, such as carrying status messages (S1) or 
labels (C2), these values will also be displayed and 
alternative values may be selected from a list. 
To conclude the examination of individual bytes, 
press the Esc key to deselect the table and return 
to the page tabs. 
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4.4.5.3 Capturing Values for K1 and K2 Bytes 

The values for detected K1 and K2 
overhead bytes can be captured and 
displayed. 

Note: This feature is available only 
after selecting Overhead Capture in 
the Measurement Selection page. 
See Section 4.3.1 for further details. 

To initiate capture, select Capture 
from the middle list box. 
The viewer displays different values 
depending on the selected 
architecture: Linear (G.783) or Ring 
(G.841). 

 

Triggers can be defined for starting and 
stopping the capture. Using the directional 
keys, highlight Trigger Setup and press Enter. 
In the Capture Trigger Setup dialog box, make 
one of the following selections in the Trigger 
Source list: 
• Manual: Capture starts after pressing Start 

firm key. 

• Compare: Capture starts when the K1 and 
K2 bytes equal the value you enter. 

• Compare Not: Capture starts when neither 
the K1 nor the K2 bytes equal the values 
you enter. 

 

When entering K1 or K2, the function keys are temporarily 
assigned the values 0, 1 and X to allow entry of binary values 
with “don’t care” bits. 

 

4.4.6 TCM results summary 

Tandem connection monitoring (TCM) 
allows the comparative performance 
of path segments to be monitored with 
the aid of the N bytes in the path 
overhead. The TCM results summary 
page is used for monitoring results for 
the forward and backward directions 
in a tandem connection. The APId 
Label (application ID path label) is 
also shown. 
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The received HP or LP path can be viewed by selecting the HP or LP radio button at 
the top of the page. The current path and its associated network operator byte will be 
shown in the top right corner of the page. 

More detailed results can be found in the Event Log, as described in Section 4.4.4.2. 

For an application note on this topic, visit our Web Site, www.jdsu.com, or contact 
the nearest Regional Sales Office as listed on the back of the manual. 

Note: The received HP and/or LP paths should be activated before starting the test. 
This can be done by selecting the HP and LP check boxes as required in the TCM 
view of the SOH Setup page. If neither box is selected, the TCM results page will not 
be available. For details See Section 4.3.3.4, Tandem Connection Monitoring. 

4.4.7 VC12 Tributary Scanning Results 

Note: Select Tributary Scan from the Measurement Selection page. See Section 
4.3.6 to configure the required setup. 

Once the Start button is pressed, the 
screen will automatically change to the 
Tributary Scan results page to display 
the test. 

Tributaries that have failed the test are 
listed in order of severity. Users can 
scroll through the list to locate specific 
channels. (Multiple failures are 
indicated below the list). In this 
example MS-REI and HP-REI failures 
are present in the 1,1:5:1 tributary. 
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A verdict of the overall result will be 
displayed on completion of the test. 

4.4.8 Repetitive BERT 

Note: The Repetitive BERT tab will become available if selected from the 
Measurement Selection page. See Section 4.3.1 for further details. 

Repetitive BERT is useful when 
commissioning a microwave link. The 
commissioning operator may be 
required to plot a graph BER against 
C/N (carrier-to-noise ratio). This is 
achieved by attenuating the signal 
until a specific BER is reached, and 
then noting the attenuation used. For 
example, in an SDH network the 
measurements could be made on a 
single channel within an STM-1 
signal, where the required BER will 
probably be between 1E-6 and 1E-3. 

 

A Repeat Period of 1 second is adequate for measuring high error rates, but this 
period can be adjusted to a maximum of 99 seconds to test for lower rates.  

Note: It is important not to confuse the results of the repetitive BERT test for a specific 
interval with those on the results page which show the results for the duration of the 
test. Further a repetitive BERT is not recommended from a delayed start. 

4.4.9 Automatic Protection Switching 

Note: The APS tab will become available if selected from the Measurement 
Selection page. See Section 4.3.1 for further details. 
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Automatic Protection Switching (APS) 
allows network devices to switch 
traffic onto a redundant line in the 
event of network problems (e.g. high 
error rates or heavy congestion). 
However, the switch over has to occur 
within a specified time, less than 
50 ms for most lines as specified by 
ITU-T (G.841 7.2.2). This is generally 
tested by breaking the working line at 
a pre-determined point and monitoring 
how long the disruption lasts. 

 

Detection can be achieved by monitoring the reduction in Quality of Service (QoS) or 
monitoring the resultant alarms. Depending on the signalling structure the following 
sensors can be selected, TSE, MS-AIS, AU-AIS, TU-AIS and Service Disruption. 
When selecting Service Disruption, the sensor activates upon detecting any of the 
following events: TSE, AIS, LOS or LOF. 

The Switch time limit (t1) can be set within the range of 10 to 2000 ms. The Gate 
Time (t2) is used to monitor multiple switches and is achieved by continuing the 
detection process for an extended period, with a range from 100 to 5000 ms. 

By checking the Repetitive box the test will repeat automatically once the switch has 
been detected. A green tick shows that the test has passed. A test will fail (shown by a 
red cross) if the switch time has not been fast enough or there has been any defect). 

4.4.10 Pointer Analysis 

Differences in the phase and 
frequency of the Virtual Containers 
with respect to the STM-N frame are 
compensated for via pointer 
movements. Healthy systems should 
exhibit low numbers of pointer events. 
Typically operators look for less than 
70 pointer events in a 24-hour period. 
Large numbers of pointer events can 
indicate network synchronisation 
issues such as tributary signals 
operating at large offsets or network 
elements not operating from the 
correct reference clock.  

 

ANT-5 displays the current pointer value together with counts of the numbers of 
Increments (+PJE), Decrements (-PJE) and New Data Flags (NDFs). The Sum is 
the number of increments and decrements, the Difference is the number of 
increments less the number of decrements. The Deviation (in ppm) is the number of 
times the pointer has moved in relation to the number of bits received. By checking the 
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Record pointer events box these events are also time stamped and recorded in the 
event log and displayed in the results summary page. 

Note: The pointer analysis page will only be available when there is an SDH signal on 
the Rx. The TU column will only be visible if there is a tributary path set within the 
signal structure. It is advisable that From Rx is set as the Clock Source in the 
Interface Setup Tx panel. 

4.4.11 Delay 

Note: The Delay tab will become available if selected from the Measurement 
Selection page. See Section 4.3.1 for further details. 

The propagation of delays can 
significantly affect the Quality of 
Service (QoS). Delays in the network 
are characterised by the round trip 
delay time. This is the time taken for a 
signal to transmit from the transmitter 
to the receiver on a loop back and is 
achieved by sending a known payload 
across the network. Factors affecting 
delay include the type of Network 
Element deployed and the line length.  

Delay measurements start when the start button is pressed, and measurements 
continue to repeat until the test is stopped. 

The Result shows the latest value, there is no history. If a good signal is received, the 
units for the result are displayed in μs if the result is less than 1 ms, or ms if it is 
greater. Where there is no valid result, an asterisk is displayed, or alternatively the 
cause of the problem is displayed if the result is due to signal problems, e.g. LOS. 

Note 1: When the Delay Measurement is turned on, the PRBS button contains the 
word Delay on the signal structure page, which is greyed out. 

Note 2: The Delay result will display Error if the transmit settings do not match the 
receive settings when the test is started. 

4.4.12 Nx64 

The ANT-5 can perform BER testing on a single user selectable 64k timeslot; where 
each timeslot has traditionally been used to carry a voice channel; alternatively 
multiple timeslots can be tested, supporting data pipe services which can consist of 
any permutation of timeslots. 
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Note: The timeslot page will only be available if 64k is set as the PDH Low Rate in 
the PDH Setup panel. Choose 2M as the PDH High Rate to select up to 32 x 64 kbit/s 
timeslots, or alternatively choose 1.5M as the PDH High Rate to select up to 24 x 
64 kbit/s timeslots. 

Selecting the Timeslot element for Tx or Rx opens the Timeslot Setup panel. (The 
element is referred to Ch1 see the graphic in section 4.3.1). 

1. Once opened select 1x64 for a single 
channel or nx64 for multiple channel 
selection from the dropdown menu. 

2. Select the required timeslots using the 
directional and enter keys as required. 

3. Press the Esc key to deactivate the list 
section and use the directional keys to 
select OK or to move to another part of the 
screen. 

Note: The ANT-5 will only be able to transmit and receive nx64 when E1 framing is 
part of the hierarchy. Channel 0 is used for FAS/NFAS and will always be greyed out; 
channel 16 (used for signalling purposes) will be greyed out if either PCM30 or 
PCM30C are selected as part of the framing structure. 

4.5 Actions Pages 

4.5.1 Injection of Defects and Anomalies 

A wide range of anomalies, modifications, and defects can be injected into the 
transmitted signal, depending upon the signal structure selected. 

If an SDH or SONET line interface is selected, the relevant anomalies and defects can 
be injected. If a PDH test signal is injected into the SDH virtual container, the relevant 
PDH anomalies and defects can also be injected. If, however, a PDH line interface is 
selected, then only the PDH anomalies can be injected. 

In addition to injecting into either the SDH, SONET or PDH structures, injection of 
TSEs (bit errors) into the relevant payload is also available using the Transmit Pattern. 
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4.5.1.1 Injection of Anomalies 

The Injection page can be used to 
inject a range of different anomalies 
into the transmit structure, either 
singly or at an average rate of 
between one error in every 102 bits 
and one error in 1010 bits, of the 
appropriate type. 
The type of anomalies to be injected 
is selected from the Type list box. The 
list of available anomaly types 
depends on the type of framing being 
used, and also whether SDH, 
SONET, or PDH hierarchies and line 
interfaces have been selected. 

 

The number of anomalies to be injected is selected from the Rate list box and can be 
set to Single or Continuous. The Continuous rates available are 1E-2, 1E-3, 1E-4, 
1E-5, 1E-6, 1E-7, 1E-8, 1E-9 or 1E-10, the available rates depending upon which 
anomaly is selected. 

To inject a single anomaly into the Tx path, set the Rate to Single then press the 
Inject firm key. The Inject firm key will now be depressed indicating that anomalies are 
being injected. To inject anomalies at a Continuous rate, set the Rate, then press the 
Start firm key. The injection icon, , displays an animated syringe when anomalies 
are being injected. To stop injecting, press the Stop firm key, the injection icon now 
disappears. 

The Inject firm key appears automatically in the Injection page. To allow injection 
from any other page, users can view the Inject firm key by pressing the Alt button. 
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4.5.1.2 Injection of Bursts errors 

As well as single or continuous errors, 
Bursts can also be injected into the 
SDH Anomaly or SONET Anomaly 
structures. The benefit of this feature 
is that these errors allow network 
elements to be stressed more closely 
under conditions that emulate real 
errors. 
Errors are injected into consecutive 
SDH or SONET frames. This process 
is then repeated, the Repetition 
Period is defined in frames or 
seconds which gives a convenient 
method of testing frame 
synchronization. 

 

Up to 4,800,000 consecutive frames can be errored. In this example, 2 consecutive 
frames are errored every 5 frames. 

2 frames

Repetition period = 5 frames  

Note: The value for the Repetition Period is always greater than the value of the 
Frames. The ANT-5 will automatically adjust the values if necessary. 

4.5.1.3 Injection of Code errors 

To allow for in-service performance 
analysis, E1 (2M), DS3, or STM-0 
code errors can be injected into the 
PDH structure. 
Continuous errors are injected at a 
ratio of 1x10-n where n = 3 to 8. 

Note: Ensure that PDH is selected as 
the hierarchy type and the PDH Rate 
is set to 2M or 45M. 
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4.5.1.4 Injection of Defects 

The Injection page can also be used 
to inject a range of different defects 
into the transmit structure. 
The type of defect to be injected is 
selected from the Type list box. The 
list of available defect types depends 
on the type of framing being used, 
and also whether SDH, SONET, or 
PDH hierarchies and line interfaces 
have been selected. 

 

To inject a defect into the Tx path, select the type of defect required and press the 
Start firm key. The Inject firm key will now be depressed and the injection icon, , 
displays an animated syringe when defects are being injected. To stop injecting, press 
the Stop firm key, the injection icon now disappears. 

The Inject firm key appears automatically in the Injection page. To allow injection 
from any other page, users can view the Inject firm key by pressing the Alt button. 

4.5.2 Injection of Overhead Bytes 

The overhead bytes can be manipulated by injecting specific values into each byte. 
This feature is available if the SDH or SONET hierarchy is selected. 

Injection of overhead bytes is available from the  tab on the Actions page. 

4.5.2.1 Injecting into bytes K1, K2, and S1 using Descriptor View 

In the Descriptor View the following 
bytes can be modified: K1, K2 and 
KS1.  
To display the Descriptor View, select 
Descriptor from the middle list box. 
The descriptor displays different fields 
depending on the selected 
architecture: Linear (G.783) or Ring 
(G.841). 
Values for the overhead bytes can be 
modified using the method described 
below: 
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1. Use the directional keys to highlight a field for the byte. 
2. Select the desired value. 
3. Repeat for other fields to be changed. 
4. To begin injection of the new byte settings, press the Apply firm key. 

Press Default to reset the byte values to those specified for the defined hierarchy and 
topology. 

Note: If you change to Injection view before pressing Apply, the values in the 
Descriptor view revert to those in the Injection view. 

4.5.2.2 Injecting into all overhead bytes using Injection View 

In Injection View, a pair of tables 
representing the complete contents of 
the overhead structure is displayed. 
To display the Injection View, select 
Injection from the middle list box. 
The viewer displays different values 
depending on the selected 
architecture: Linear (G.783) or Ring 
(G.841). 
If the Rate is set to STM-4 or STM-16, 
a numerical entry box will be available 
to select the channel. 

 

Selecting Default applies default values for the selected topology. 

Byte values are shown as follows: 

Hex value The hexadecimal value of the received or transmitted byte. 
‘—’ ‘—’ Indicate bytes for which a value cannot be determined. 
‘TI’ ‘TI’ indicates bytes for which a correct trace identifier value has been 

recognised. 
‘xx’ ‘xx’ indicates bytes which may not be injected. 

The POH table is displayed on the right of the window, and its contents will depend 
upon the signal structure that has been selected. 
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To modify a particular overhead byte, select the 
appropriate table using the directional keys and 
press the Enter key; individual bytes can then be 
selected using the directional keys. When a byte is 
selected and the Enter key is pressed, the 
Overhead Zoom - Injection window will appear with 
the details of that byte. 

Modify the value of the byte by changing its hexadecimal, binary, or ASCII value. 
When one of these fields is highlighted, the function keys change to support data 
entry. For more information on entering data in hexadecimal, binary, or ASCII fields, 
see Section 4.3.3.2, Trace Identifiers. 

Where an overhead byte is used for a special 
purpose, such as carrying status messages (S1) or 
labels (C2), these values will also be displayed and 
alternative values may be selected from a list. 
To apply the entered value, select OK. 
To conclude the modification of individual bytes, 
press the Esc key to deselect the table and return to 
the page tabs. 

The new values for overhead are transmitted immediately after you change them in 
the Overhead Zoom – Injection window. 

To inject overhead bytes over a specific time span, press the Start and Stop firm 
keys. 

4.5.3 Pointer generator 

Each SDH frame contains an Administrative Unit (AU-n) and a Tributary Unit (TU) 
pointer. The value of the pointer can be changed on the Pointer Generator page. The 
Pointer Generator page can be displayed by pressing the  button and then 

selecting the  tab. 

Select the pointer you want to modify 
from the View list: AU or TU. In the 
Type field, select the type of 
adjustment to make, DEC for 
decrement, INC for increment, or 
INC/DEC to increment and then 
decrement the pointer at the frame 
rate you specify.  
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If you select INC/DEC, the frame pointer will be incremented after the specified 
number of frames are detected, and then decremented after the next series of frames 
are detected. For example, if you specify 100 as the frame rate for INC/DEC insertion, 
the unit will increment the pointer after it detects 100 frames, and then decrement the 
pointer after it detects the next 100 frames. 

From the mode list, select the method for incrementing or decrementing the pointer. If 
you specified INC/DEC as the adjustment type, or selected   Continuous as the 
mode, the Frame Rate field appears. In the field, type the number of frames after 
which the adjustment occurs. For example, if you type 400, the frame pointer is 
incremented or decremented after detection of 400 frames. The Frame Rate field 
accepts values between 100 and 8000. 

If you specified INC/DEC as the adjustment type, and Single as the mode, the Interval 
field appears. In the field, type the interval (in us) after which the adjustment occurs. 

Pressing the TU or AU firm key initiates the pointer generator using the current 
settings. 

4.5.4 TCM generator 

The overhead bytes for the current mapping (N1 high path, N1 low path, and N2 low 
path) can be manipulated by inserting or removing alarms and defects into the TCM 
generator. Before inserting alarms and defects, you must configure the ANT-5 for 
TCM generation.  

To enable this feature, do the 
following: 

Press the  button, and then 

select the  tab to display the 
Overhead Setup page. 
Set the View to TCM. 
Under Tx Path, select HP, LP, or both 
(if you want to edit the values for both 
the N1 and N2 byte). 
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4.5.4.1 Sending alarms and defects to the TCM generator 

To send alarms and defects to the 
TCM generator, do the following: 

Press the  button, and then 

select the  tab. 
Select the byte (HP or LP) for TCM 
generation. 
Select the alarms and defects you 
want to insert. 
 

If you want to insert a TC-APid identifier, use the keypad to type the id. The TC-APid 
field accepts up to 15 alpha-numeric characters. 

If you want to insert a TC-IEC error, use the keypad to type the value. The TC-IEC 
field accepts values ranging from 0 to 8 for the N1 byte, or 0 to 2 for the N2 byte. 

Select ON. The values are sent to the TCM generator for the currently selected byte.  

If you want to send alarms and defects to the generator for the other byte, select the 
byte, and then repeat the process above. 

Note: Selecting the Default button restores the default settings.  

If you change your selections or modify the TC-APid or TC-IEC values after selecting 
ON, an Apply firm key appears. You must select Apply to send the new alarms, 
defects, or values to the TCM generator. 

4.6 Enhanced Functionality 

4.6.1 Optical Power Measurement 

To identify optical level problems, the 
optical power measurement measures 
the received optical signal level to a 
resolution of 1 dBm with an accuracy 
of ±3 dB. In this example, an Optical 
Level of -14 dBm has been received. 
Overload protection is active during 
optical power tests. If an overload 
occurs, the protection switch opens 
and a message appears in the Results 
Summary page. Pressing OK in the 
message box clears the alarm and 
closes the protection switch. 
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4.6.2 PECL NRZ STM monitor port 

With the Rate set to STM-1 NRZ, STM-4 NRZ, 
or STM-16 NRZ, signals can be monitored at 
the electrical monitor point without the need for 
optical splitters. 

4.6.3 E1 Hi-Z input 

A high input impedance setting for the E1 port 
enables E1 signals to be monitored without a 
PMP.  

4.6.4 Testing PDH T1 Interfaces 

Using a standard Bantam cable, the 
ANT-5 can test T1 ANSI based 
tributaries as illustrated in this graphic.

 

4.7 Saving and exporting results and setups 

Pressing the Menu key and selecting File provides a drop-down menu which can be 
used to Open, Save and Export configuration data and results and to Print results to 
the serial port. Selecting Options from the Tools menu shows the Current options 
installed. This area is also used to Install and Uninstall features as required. The 
Help Menu provides access to application information features. 
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File > Open > 
Configuration 

Select this option to load an instrument configuration into the 
ANT-5, which has previously been saved either to a card or to the 
ANT-5 RAM. The file window will list all valid configuration files on 
either the card if it is inserted, or in the ANT-5 RAM, along with 
their date and time of creation and a brief description. 

File > Open > 
Results 

Select this option to load a set of test results from a previous test 
into the ANT-5, which has previously been saved either to a card or 
to the ANT-5 RAM. The file window will list all valid results files on 
either the card if it is inserted, or in the ANT-5 RAM, along with 
their date and time of creation and a brief description. The results 
file also includes the corresponding configuration from the time of 
the saved test, and will change the configuration of the instrument 
when the results file is loaded. 

File > Save > 
Configuration 

Select this option to save an instrument configuration from the 
ANT-5 either to a card or to the ANT-5 RAM. A configuration can 
either be saved to an existing file, or a new file can be created. If a 
new file is required, the new file name and a brief description can 
be manually entered using the ANT-5 keyboard. Assuming the 
ANT-5 is networked the configuration can also be saved and 
transferred to other units using FTP. 

File > Save > 
Results 

Select this option to save a set of test results from the ANT-5 either 
to a card or to the ANT-5 RAM. The set of results can either be 
saved to an existing file, or a new file can be created. If a new file is 
required, the new file name and a brief description can be manually 
entered using the ANT-5 keyboard. Results saved using this option 
can only be read back into the ANT-5 instrument. 

File > Export > 
Configuration 

Select this option to export an instrument configuration to a card in 
CSV (comma separated values) format. Results exported using this 
option can be read by other PC applications, but cannot be 
imported back into the ANT-5 instrument. 

File > Export > 
Results 

Select this option to export a summary of the test results to a card 
in CSV (comma separated values) format. Results exported using 
this option can be read by other PC applications, but cannot be 
imported back into the ANT-5 instrument. 

File > Print >  Select this option to 
print the test results to 
the serial port. A 
typical printout is 
shown on the next 
page. 
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Note 1: To use the Print Results feature successfully, it is important to have the 
correct Printer Driver and Serial Port settings rather than relying on the simple serial 
port tests mentioned in Sections 2.7.1 and 2.8. 

Note 2: Previous mixed mode configurations saved prior to software version 08.00 will 
no longer be valid. 

Performance Analysis (M.2100)
Near End Far End

ES 6 2.40964% 0 0.00000%
EFS 243 97.59035% 217 100.00000%
SES 6 2.40964% 0 0.00000%
UAS 20 7.43494% 26 10.69959%

Verdict

Path Allocation     100%

Test Summary
Total seconds: 268
BER: 0.000E+00

Signal Structure Setup

PRBS15 2M
Framed

VC-12 STM-1
AU-4

D

U

T
PRBS15 2M

Framed
VC-12 STM-1

AU-4

Electrical1:1:1

Electrical1:1:1

Transmitter Receiver

Interface Setup Interface Setup
Clock Source: Internal Input: Electrical
Output: Electrical Line Code: CMI
Line Code: CMI Sensitivity: ITU-T

Channel Setup Channel Setup
STM-N STM-1 STM-N STM-1
TUG-3 1 TUG-3 1
TUG-2 1 TUG-2 1
TUG-12 1 TUG-12 1
Timeslot 1 Timeslot 1

Hierarchy Setup Hierarchy Setup
Hierarchy Type: SDH Hierarchy Type: SDH
SDH Rate: STM-1 SDH Rate: STM-1
AU Mapping: AU-4 AU Mapping: AU-4

Virtual Container Setup Virtual Container Setup
VC Mapping: VC-12 VC Mapping: VC-12
Bulk:: OFF Bulk:: OFF

PDH Setup PDH Setup
PDH Rate: 2M PDH Rate: 2M
PDH Mode: Framed PDH Mode: Framed
Mapping Mode: Async. Mapping Mode: Async.
Framing: PCM30 CRC Framing: PCM30 CRC

Pattern Setup Pattern Setup
Pattern Type: PRBS15 Pattern Type: PRBS15

Defect/Anomaly
LOF 5
B1 1
MS-AIS 19
B3 1
RDI-2 25

Transmitter

Receiver
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4.7.1 Exporting data to a spreadsheet using a storage card 

Assuming that an appropriate driver is available on the PC or laptop, the following 
example demonstrates how test results can be saved to a spreadsheet. 
1. Insert an appropriate card into the ANT-5. 
2. Stop the test and press the Menu key. 
3. Select Export from the File menu option. 
4. Select Results. 
5. Using the arrow keys highlight card: and press the enter key. 
6. Select <new file> and enter a filename. (The file will automatically be saved with 

the extension .csv) 
7. Insert the card into the appropriate slot on the PC or laptop and using a suitable 

application open the file. 

!
 

Note: Ensure that the necessary drivers are enabled and the card is located in the 
correct slot. Contact your IT department for further assistance if required. 

8. This file displays a host of information relevant to the results and the configuration 
of the unit. 

4.8 On-Screen LED Indicators 
The top portion of the screen is used 
by the SDH Access Tester application 
to simulate LED indicators on-screen. 
Red LED’s are used to display 
information that is relevant to the 
current setup, whilst yellow LED’s 
show historic alarms. The LED will 
stay yellow until a new test is started 
or of a configuration is changed. 

 

LEDs can be set to be latching or non-latching in the LEDs section of the System 
menu, which can be displayed by pressing the Alt + Menu key at any time. If the 
Latching box is checked, you can reset all latched LED’s by selecting Reset LEDs 
from the System menu or alternatively LEDs can be reset from within the ANT-5 
application by pressing Menu, and selecting Tools > Reset LEDs. 

The sixteen on-screen LEDs are arranged as shown below: 
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LOS Loss of Signal Lof/Oof Loss of Frame 

RS/MS Regen / Multiplex Sections B1 Regen. Section error monitor 

AU Administrative Unit B2 Mux section error monitor 

HP High Order Path B3 HO path error monitor 

TU Tributary Unit LP Low Order Path 

P-RDI Path Remote Defect Ind. Fas/Crc FAS / CRC Error 

P-AIS Path AIS P-LOF Path Loss of Frame 

TSE Test Sequence Err. (Bit Err.) LSS Loss of Sequence Sync. 

4.9 User Preferences 
User preferences enable the user to 
‘customise’ parts of the ANT-5 setup to suit 
their typical requirements. 
User preferences can be set from within the 
ANT-5 application by pressing Menu and 
selecting Preferences from the Tools 
menu. 

1. Use the directional keys to highlight the icons. 
2. Press the Enter key to activate this area. 
3. Use the directional keys to select either the General Preferences or the Printer 

Header Defaults screen. The graphic above shows the General Preferences 
screen which indicates that the laser, speaker and the ANT-5 application will 
launch automatically. The name of the operator and user information can be 
inserted from the Printer Default screen. 

Note: Another icon will be present only when the GUI is used with the Remote 
Operation option. Select the cable icon to change the IP Address of the ANT-5. If the 
IP address is edited whilst running the application, close and restart to enable the 
change. 



The SDH Access Tester Application  

Page 92 ANT-5 

4.10 Installed options 
Options currently installed can be displayed 
by pressing the Menu key from within the 
ANT-5 application, and selecting Options 
from the Tools menu. This screen is also 
used to install and uninstall options, See 
Section 5.1, Enabling customer-installed 
options, for further details. 
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5. Optional software for the ANT-5 
Options that can be currently purchased include: 

Option BN Number 
PDH Mux/DeMux 4565/93.58 (New Build) 
Concatenated Mapping 4565/93.59 (New Build) 
Remote Operation 4565/93.60 (New Build) 
Remote Control 4565/93.61 (New Build) 
SONET 4565/93.62 (New Build) 
AU3 & VT* Mappings (*requires SONET option) 4565/93.53 (New Build) 
ATM (see section 6) 4565/93.54 (New Build) 
PLCP for ATM in DS3 4565/93.67 (Factory Installed)
IMA Monitor 4565/93.64 (New Build) 
ATM Ping 4565/93.65 (New Build) 
ATM Enhanced (requires  ATM option) 4565/93.66 (New Build) 

Note: Options purchased with a factory built ANT-5 will already be installed. 

5.1 Enabling customer-installed options 

New, customer-installed options purchased for the ANT-5 will be supplied with an 
access code. Options are enabled as follows: 

From within the application an access Key 
is used to install the option into the unit by 
pressing Menu and selecting Options from 
the Tools menu. 

Note: If an invalid key has been entered incorrectly three times, refer to the nearest 
technical assistance centre for advice. (This will not prohibit the unit being used for 
other purposes). 

Options that can be currently purchased include: 

Option BN Number 
PDH Mux/DeMux 4565/95.58 (Customer Installed) 
Concatenated Mapping 4565/95.59 (Customer Installed) 
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Option BN Number 
Remote Operation 4565/95.60 (Customer Installed) 
Remote Control 4565/95.61 (Customer Installed) 
SONET 4565/95.62 (Customer Installed) 
AU3 & VT* Mappings (*requires SONET 
option) 

4565/95.53 (Customer Installed) 

ATM (see section 6) 4565/95.54 (Customer Installed) 

5.2 PDH Mux/DeMux 

5.2.1 PDH Mux Tx  

SDH, SONET, and PDH network elements 
process PDH signals from various hierarchies. 
Complex, interlocking signal paths can result, 
particularly within modern optical cross-
connects. Here, the ANT-5 can be used to test 
complex switching functions. 
The PDH Mux feature allows the generation of 
ITU-T Mux chains from E1 to E4, starting and 
finishing at any intermediate rate with the 
exception of E2 (i.e. E1/E3, E1/E4, E3/E4).  

The generation feature allows the insertion of alarms and errors at all levels in the 
chain (including E2). 

Selecting NFAS setup… opens the NFAS Setup Tx panel. (This is available only 
when the 2 Mbit/s (E1) signal structure has been selected for transmission). 

Note: The Tx hierarchy type should be set to PDH to activate the PDH Mux. 

5.2.2 PDH DeMux Rx  

The PDH DeMux feature allows the analysis of 
ITU-T DeMux chains from E4 to E1 with the 
exception of E2 (i.e. E3/E1, E4/E1, E4/E3). 
The analysis feature allows detection of all the 
alarms and errors generated. This enables in-
service monitoring of specific channels 
contained in PDH signals. 

 

Note: The Rx hierarchy type should be set to PDH to activate the PDH de-Mux. 
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5.2.3 Sa Bit generation Tx 

The Spare (Sa) bits in the NFAS (Not Frame 
Alignment Signals) of an E1 frame are available 
for specific purposes, and can be used, for 
example, to provide a remote loop back of a far 
end tributary. Bits can be used to control far 
end equipment for testing, typically using a 
loop-back. 

 

The A-Bit (indicating the remote alarm) and spare Sa bits (Sa4 – Sa8) can be set. For 
each Sa bit it is possible to set 8 binary values. These will be transmitted in 
consecutive NFAS. 

5.2.4 Sa Bit monitoring 

Assuming the Rx signal structure is 
configured to receive framed E1 
signals, then Sa bits can also be 
monitored by pressing the Results 
firm key and selecting the SA tab. 

 

5.3 Concatenated Mapping 

Concatenated STM-4 is being used increasingly to carry high data rate services such 
as, ATM, IP and multimedia. 

Concatenated Mapping supports bulk 
contiguous concatenation, which treats the 
STM-4 payload as a contiguous virtual 
container. The alternative (which is not 
supported) is virtual concatenation (STM-4v); 
this uses 4 x VC4 containers to create a virtual 
VC4-c container. 

 

A test pattern can be injected throughout the contiguous concatenated payload of the 
Virtual Container in either transmit or receive mode as required. 
1. Set the Rate within the Hierarchy Setup panel to STM-4 Optical. 
2. Set VC Mapping within the Virtual Container Setup panel to VC4-4c. 
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Note: VC4-16c is available when the interface is set to STM-16. 

5.4 Remote Operation 

5.4.1 Setting up the remote ANT-5 

Remote Operation is achieved by establishing a suitable communications link over an 
Ethernet LAN. Once the link has been successfully set up, the PC/Laptop can 
communicate with the ANT-5 using the supplied version of the ANT-5 GUI faceplate. 

ANT-5Ethernet Ethernet

Host computer  

Note 1: The following illustrates how remote access can be achieved using the 
network, it is not exhaustive and other scenarios may be equally valid. Please ensure 
the cable is less than 3 metres from the ANT-5 to the RJ-45 socket. 

Note 2: Care should be taken not to confuse the E1 120Ω (RJ-48) and the Ethernet 
port <···> (RJ-45). See the illustration on page Error! Bookmark not defined.. 

Note 3: Remote operation currently supports the SDH Access Tester Application and 
is available in all languages supported by the ANT-5 local GUI. 

The following is required and assumed to be working: 

• Complete ANT-5 unit with all necessary cables. 

• 10BaseT connection. 
1. Liaise with your IT department for a static IP address, the Subnet Mask and 

Gateway of the network to which the ANT-5 will be connected. 
2. In the Systems > Comms > Ethernet menu of the ANT-5, edit the IP Address, 

Subnet Mask and Gateway to those specified by the IT department and the 
Transceiver to the network connection type. 

3. A connection to an external power supply is advisable. Reboot the ANT-5, launch 
the REMOTE application and leave on. 

Note: As an example, the connection to the network can be made via an Ethernet 
card plugged into the RJ-45 Ethernet connector <•••> on the left side of the ANT-5 
(see illustration on page Error! Bookmark not defined.). A static IP address will be 
required for the particular MAC address of the PC card. Refer to section 2.8.1 for 
information on communications configuration. 

5.4.2 Selecting the Language 

Follow steps 1–4 below to select the language for the Remote Operation Client. 
1. Launch the ANT-5 Remote Operation client.  
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4. Display the User Preferences page 
using the top icon in the list. 

 
 
3. Select the language for remote operation. 
4.  Exit the Remote Operation Client, and then launch it again. 
The language is set for remote operation. 

Note: For instructions on setting up the ANT-5 to support Simplified Chinese text, see 
Appendix F – Simplified Chinese Language Support. 

5.4.3 Software Installation and operation 

Note: Ensure that the ANT-5 unit has been fully upgraded and that the corresponding 
version of the client software has been installed and is used. 

Follow steps 1–3 below if the remote operation client needs to be installed. 
1. Insert the ANT-5 Upgrade CD-ROM into the CD drive of the PC.  
2. From Windows click on Start > Run and type in D:\ANT-5 Remote Operation 

Client\setup.exe (replace D with the drive letter for your CD-ROM drive if 
necessary). 

3. Follow the on-line instructions to complete the installation. 

4. Highlight REMOTE and press 
enter. 
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5. The ANT-5 unit will then display 
Waiting for connection… to alert 
other users of the unit’s purpose. 

6. From the PC launch the application 
by clicking on Start > Programs > 
ANT-5 Remote Operation Client. 

7. When the application is launched 
you will be prompted for the IP 
address of remote unit which is 
either the Ethernet > IP Address 
or the PPP > Local IP Address of 
the remote ANT-5 depending on 
the type of connection made. 
(Refer to section 2.8.1 for further 
information).  

Note 1: The next time the application is launched, the previous IP address will be 
shown as default, click on OK to proceed. If required, the IP address can be edited. 

Note 2: When typing in the ANT-5 IP address into a PC environment care should be 
taken to avoid any leading zeros. For example 141.169.126.076 would be replaced 
with 141.169.126.76. However, all twelve characters are needed for the ANT-5.  

Note 3: Edited IP addresses will be available after the ANT-5 has been re-booted. 

After a short while the ANT-5 graphical user interface will load on the PC, green LEDs 
will flash in the Tx and Rx boxes of the ANT-5 indicating that the link has been 
established.  

The PC’s mouse and keyboard are 
used to operate the remote ANT-5 
just as if you were sitting in front of it. 
Use the PC’s keyboard cursor keys to 
move around the ANT-5 and the 
mouse to select the ANT-5 keyboard 
keys. For ease-of-use the function 
keys F1-F6 match the function keys 
on the ANT-5. Key F10 takes on the 
role of the ANT-5 menu key. 
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Tip: Create a directory on your PC, e.g. ANT-5. Select Menu > File > Save > 
Configuration to save configuration files to this directory which later can be opened 
by selecting Menu > File > Open > Configuration. Alternatively files can be copied to 
other units using FTP, See Section 3.3.2, File Transfer for further details. 

5.4.4 Keyboard equivalents 

While working in remote mode, you can use your PC’s function keys to emulate 
pressing various keys on the instrument. The following illustration shows the mapping 
between function keys and instrument keys. 

F9

F10

F1 F3 F6F4 F5F2

Function keys

Information key

Menu key

F8 Off key (exits remote application)

F7 On key (displays version information)

ANT-5 :  SDH Access Tester

 

In addition, the following keyboard keys correspond to keys on the ANT-5: 

Enter 
 

 Del Del
 

Alt Alt
 

 Esc Esc
 

Cursor keys 
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5.4.5 Exporting 

From the GUI faceplate select Menu > File > Export. From the standard Windows 
dialog box, .csv files can be saved to any directory on your PC.  

5.4.6 Printing 

From the GUI faceplate select Menu > File > Print. A standard Windows dialog box 
will allow users to select and configure a printer. 

5.4.7 Remote Operation Troubleshooting 

5.4.7.1 General Troubleshooting Tips 
1. Ensure that all physical connectors are secure 
2. Check that IP address of the physical ANT-5 matches the one used from the GUI 

faceplate. (See Sections 2.8.1 and 4.9). 

3. Press i  from the GUI faceplate. If the M/M Version shows a series of zeros, 
check the IP address and re-launch the application from the PC. 

4. Errors may occur on re-launching the ANT-5 application if previously it has failed to 
shutdown correctly. In this instance delete the Auto.A5C file from your C: drive 
and re-launch the application from your PC. 

5. The Remote Operation Client may have terminated improperly during a prior 
session, leaving a process running on your PC. To delete the process, launch the 
Task Manager, and then select the Processes tab. Find the process named 
ant5rc.exe, and then end the process. 

6.  On occasion, Windows Updates can cause a loss of communications. If this 
occurs, please disable the Windows Updates while using the Remote Operation 
feature. 

5.4.7.2 Troubleshooting for Windows XP 

If you are using Windows XP, perform the following steps to improve performance of 
remote operation: 
1. Select Start->Settings->Control Panel. Double-click System, and click the 

Advanced tab. Select Settings under the Performance category. Select the 
Advanced tab on the Performance Options page. Select Background Services for 
Processor Scheduling. 

2. Ensure you have as few applications open as possible in order to give priority to 
the Remote Operation Client. Ideally you should reboot your machine and have 
nothing running. Ensure your firewall is allowing communication to and from the 
PC. 

3. Remove the ctmon.exe process. This removes Alternative User Input which may 
be required by Chinese users. For detailed instructions on removing ctmon.exe, 
see http://support.microsoft.com/default.aspx?kbid=282599.  

http://support.microsoft.com/default.aspx?kbid=282599
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5.4.7.3 Removing the Time Zone environment variable 

Previous versions of the ANT-5 software required definition of a time zone variable. If 
you defined a time zone variable, you must remove it. 

Windows 95: 
1. Select Start > Run. 

 
2. In the Run dialog box, type msconfig.exe and click OK. The System Configuration 

Utility appears. 
3. Click the Autoexec.bat tab. 
4. If there is a statement such as SET TZ=GMT+1 (or similar), delete it. 
5. Click OK, and exit the System Configuration Utility. 

Windows NT: 
1. Select Start > Settings > Control Panel > System. 
2. Click the Environment tab. 
3. If an environment variable TZ appears, delete it. 
4. Exit the Control Panel. 

Windows 2000 and Windows XP: 
1. Select Start > Settings > Control Panel > System. 
2. Click the Advanced tab. 
3. Click Environment Variables. 
4. If an environment variable TZ appears, delete it. 
5. Exit the Control Panel. 

5.5 Remote Control 

Refer to the ANT-5 Remote Control User Manual for more information. 
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5.6 SONET 

5.6.1 Introduction 

Synchronous optical network, known as SONET, is the standard for synchronous 
operation used primarily in North America and is defined by ANSI T1. (American 
National Standards Institute – Telecommunications 1). 

SONET and SDH share many common principles of operation and architecture. A 
comparison of the transmission rates supported by ANT-5 is given below: 

SONET signal SDH 
signal 

Transmission 
Rate Mbit/s 

Electrical STS-3 Optical OC-3 STM-1 155.52 

 Optical OC-12 STM-4 622.08 

 Optical OC-48 STM-16 2488.32 

The bit rates depend on the mapping options fitted. 

5.6.2 Hierarchy Setup 

SONET can be chosen as the Hierarchy Type by selecting the Hierarchy element 
from the Tx or Rx panel as required.  

If an optical option is fitted then by selecting an 
optical Rate e.g. OC-3 as in this example, the 
Output will automatically change to Optical in 
the Interface Setup panel. 

 

5.6.3 Synchronous Payload Envelope Setup 

SPE Mappings can be selected from the 
Synchronous Payload Envelope Setup 
element. This element will not be available if a 
PDH interface has been selected. 
Bulk should be selected as the Tributary if 
bulk testing of the virtual container is required. 
The test pattern will then be injected across the 
whole of the Synchronous Payload Envelope. 

 

If the unit supports Concatenated Mapping (See Section 5.3) then a test pattern can 
be injected throughout the contiguous concatenated payload in either transmit or 
receive mode as required by: 
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1. Setting the Hierarchy Type to SONET. 
2. Set the Rate to OC-12. 
3. Set SPE Mapping within the Synchronous Payload Envelope panel to 

STS-12c SPE. 

Note: VT1.5 and VT2 mapping will also become selectable if the AU3/VC11/SONET 
VT mappings option has been purchased and enabled. 

5.6.4 Channel Setup 

The channel for testing will depend on the parameters set for the hierarchy and 
synchronous payload envelope.  

Mappings to the OC Channel 

OC 1 2 3 4 5 6 7 8 9 10 11 12 

STS-N 1 1 1 2 2 2 3 3 3 4 4 4 

AU-3 channel 1 2 3 1 2 3 1 2 3 1 2 3 

5.6.5 PDH Setup 

Only bit rates and framing types appropriate to the SONET configuration will be 
displayed as options within this panel. 

5.6.6 SONET LED Indicators 

LOS Loss of Signal Lof/Oof Loss of Frame 

Line-L Line overhead B1 Section error monitoring 

STS-P STS Path overhead B2 Line error monitoring 

VT-V VT Path overhead B3 SP error monitoring 

P-RDI Path Remote Defect Ind. Fas/Crc FAS / CRC Error 

P-AIS Path AIS P-LOF Path Loss of Frame 

TSE Test Sequence Err. (Bit Err.) LSS Loss of Sequence Sync. 
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5.6.7 SONET information 

SONET structure for ANT-5 

 

SONET Anomalies and Defects 
The following table lists the SONET Anomalies and Defects pertinent to ANT-5, their 
meanings and detection criteria. 

 Anomalies Detection Criteria 
LOS Loss of signal All-zero pattern for 2.3 μs ≤ T 

≤ 100 μs  

LOF Loss of frame If SEF persists for ≥ 3 ms 

AIS-L Alarm Indication Signal – Line K2 (bits 6,7,8) = 111 for ≥ 5 
frames 

RDI-L Remote Defect Indication – Line K2 (bits 6,7,8) = 110 for ≥ z 
frames (z = 5 to 10) 

LOP-P Loss of Pointer – STS Path 8 to 10 NDF enable 8 to 10 
Invalid pointers 

AIS-P Alarm Indication Signal – STS 
Path 

All “1” in the STS pointer 
bytes H1, H2 for ≥ 3 frames  

UNEQ-P Unequipped – STS Path C2 = “0” for ≥ 5 (≥ 3 as per 
T1.231) frames 

RDI-P Remote Defect Indication – STS 
Path 

G1 (bit 5) = 1 for ≥ 10 frames 
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 Anomalies Detection Criteria 
TIM-P Trace Identifier Mismatch – STS 

Path 
Mismatch of the accepted 
and expected Trace Identifier 
in byte J1 (64 bytes 
sequence) 

PLM-P Payload Label Mismatch – STS 
Path 

Mismatch of the accepted 
and expected Payload Label 
in byte C2 for ≥ 5 (≥ 3 as per 
T1.231) frames 

 

 Defects Byte or Detection Criteria 
B1 Section error mismatching B1 

B2 Line error mismatching B2 

REI-L Remote Error Indication – Line Number of detected B2 errors 
in the sink side encoded in 
byte M0 or M1 of the source 
side 

B3 Path error mismatching B3 

REI-P Remote Error Indication – STS 
Path 

Number of detected B3 errors 
in the sink side encoded in 
byte G1 (bits 1, 2, 3, 4) of the 
source side 
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5.7 SDH AU-3/SONET VT Mapping 

AU-3 Mapping enables the testing of DS-1, E1, E3 and DS3 tributaries mapped into 
STM-1 via VC-3/ AU-3, as shown in the following diagram. 

 

The VT mapping function enables the testing of DS-1 and E1 tributaries mapped into 
an STS-1 SPE via VT1.5 and VT2 SPEs as shown in the following diagram. However, 
this option also requires the SONET option BN 4565/00.62. 
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6. Asynchronous Transfer Mode – ATM 

6.1 ATM Overview 

ATM is a cell-oriented switching and multiplexing technology that uses fixed-length 
packets to carry different types of traffic. Like packet switching technologies such as 
frame relay and TCP/IP, ATM integrates the multiplexing and switching functions but 
in contrast to circuit switching it is also well suited for bursty traffic. ATM therefore 
allows communication between devices that operate at different speeds.  

6.1.1 The ATM Reference Model 

In the sections that follow, the user interface has been described with reference to the 
ATM model, namely, the Physical layer, the ATM layer and the Adaptation layer. The 
following diagram shows a basic layer model for ATM.  

Transmission medium

Physical Layer -
adaptation of cells to the tranmission medium

ATM Layer -
multiplexing and switching of cells

AAL Layer -
adaptation of data to cell structure

Higher-layer protocols

Application

 

6.2 Introduction 

The ATM S/W option (4565/93.54) expands the applications of the ANT-5 to cover use 
in ATM networks. The measurement methods and user interface have been designed 
for applications involving user-network interfaces (UNI) and network-network 
interfaces (NNI). ATM testing is available for the STM-1/4/16, OC-1/3/12/48, DS1/3 
and E1/3 data rates. 
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Note: This section assumes that you are familiar with the functionality of the graphic 
user interface. However, before proceeding you may wish to review section 4, The 
SDH Access Tester Application.  

6.2.1 ATM Setup and Result tabs 

ATM Tabbed Setup pages 

 
ATM Setup Summary  

 
ATM setup page 

 
Channel explorer setup page  

 
AAL-2 / AAL-5 setup page 

 
ATM Tabbed Result pages 

 
ATM Cell Statistics  

 
ATM Quality of Service 

 
Channel Explorer results  

 
AAL Statistics 

 
Channel Traffic Analyzer 
(CTAN) 

   

6.3 Configuring the Physical Layer 
The signal structure for the particular 
device or system under test has to be 
configured before setting any ATM 
parameters.  
Following the Tx setup, this example 
shows a PRBS23 pattern passing into 
a 140Mbit/s Unframed PDH signal. 
This is mapped into a virtual container 
VC-4 which is then aligned into an 
administrative unit AU-4 and finally 
multiplexed into an STM-1, using an 
electrical interface. See section 
4.3.1, Signal Structure setup page 
for further details on configuring the 
physical layer. 

 

In most cases the user interface for the Tx is the same as the user interface for the 
Rx. An exception to this rule is the ATM Header Rx, where a VCI and/or a CLP filter 
can be enabled. See section 6.4.2 for further details. 

Where the system under test is symmetrical, and the Tx and Rx structures are 
required to be identical, time can be saved by setting up either the Tx or the Rx 
structure, and then pressing either the  or  keys as appropriate. The 
structure will be copied from Tx to Rx, or vice versa, as selected. 
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Note: When the physical interface is 2M, and PCM31 or PCM31C framing is selected, 
you can reserve timeslot 16 on the PDH Setup Tx and Rx pages to allow compatibility 
with other 2M ATM devices.  

 

6.3.1 Virtual Container Setup Tx  

Once the physical layer is configured correctly, 
open the Virtual Container Setup Tx panel, 
and select the Tributary ATM from the 
dropdown menu, then click on OK. 

 

You will notice that the signal structure page has changed, similar to the diagram 
shown below. 

Interface

Switch to ATM
signal structure

Virtual
Container Hierarchy
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6.4 Configuring the ATM Layer  

6.4.1 The ATM structure 

Select either the  tab from the 
right of the screen, or the ATM icon 
from the structure setup page. A 
graphic similar to the one on the right 
will be displayed. The ATM structure 
can now be configured.  
In this diagram Channel A is 
displayed as the channel under test. 
The Channel A panel is used to 
switch to view other channel setups, 
(assuming concurrent channels have 
been selected). See section 6.4. 

 

Toggle to view
Channel B setup

ATM HeaderATM SDU

ATM Service
Contract
Attributes

Switch to signal
structure

ATM Traffic
Off/On

ATM Layer

 

Note: Use the tab  or icon to switch to the physical signal structure layer at any 
time. 

UNI or NNI can be selected as the Interface. In 
this example the Interface is set to UNI and the 
Payload Scrambler has been turned on. The 
transmitter can send Idle or Unassigned cells. 
In this example, the ATM cell stream will be 
stuffed with Unassigned cells when no traffic is 
sent. Finally, select the Channel. Channel A 
tests the foreground channel, and Channel B is 
used to carry a fixed payload type on the 
background channel. Click on OK when you 
have set the parameters. 
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From the signal structure page move the directional keys over Traffic Off panel. The 
Enter key can be used to switch Traffic On or Traffic Off as required. 

6.4.2 ATM Header Tx 

Sets the parameters for the ATM Header. The 
Virtual Path Indicator VPI and Virtual Channel 
Indicator VCI are used for switching purposes.  
VPI identifies the cell belonging to a particular 
path, whilst the VCI identifies the cell belonging 
to a particular channel. 
Four bits are used for Generic Flow Control 
GFC. These bits control the flow of data 
between the user and the network. GFC can 
only be set if UNI is selected as the Interface. 
See section 6.4, Configuring the ATM Layer 
for further details. 

The CI field indicates if the congestion indicator is ON or OFF. When ON, the network 
elements reduce the allowed cell rate during network congestion. 

Cell Loss Priority CLP allows cells to be classified as high priority CLP-0 or low priority 
CLP-1. In the event of congestion, cells that are set to CLP-1 will be discarded first. 

The Payload Type field selects the ATM payload.  If you select AAL-2 or AAL-5, an 
additional “AAL” block appears, replacing the ATM SDU box and an AAL tab appears. 

Note: AAL-2 and AAL-5 are part of the “ATM Enhanced” option. 

Click on OK when you have set the parameters. 

6.4.3 ATM Service Contract Attributes Tx 

Sets the parameters for the Service Contract. 
A Constant Bit Rate CBR or a Variable Bit 
Rate VBR can be selected as the Profile 
Type. In this example a CBR has been 
selected.  
A CBR is a class of service that guarantees 
the transmission at a constant bit rate, thus 
emulating a dedicated transmission link. 
In this example a Peak Cell Rate PCR of 25 
cells per second will be sent.   

Note: Cells sent at a rate close to 100% of the maximum cell rate will be rounded-up. 
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In this example a VBR has been selected as 
the Profile Type. The user can define the 
PCR and the Sustainable Cell Rate SRC. In 
this example a repeated pattern of 100 PCR 
cells will be sent during T1, where T1 in this 
example = 1 second. This will be followed by 
50 SCR cells during T2, where T2 = 1 second 
(100x10 ms) 

 

6.5 Configuring the Adaptation Layer 

Select either the  tab from the 
right of the screen, or the AAL icon 
from the structure setup page. A 
graphic similar to the one on the right 
will be displayed. The AAL structure 
can now be configured.  
 

 

6.5.1 ATM SDU Setup Tx 

Sets the Service Data Units SDU for the 
device under test. In this example the 
Payload Type has been set to O.191.  
O.191 describes a diagnostic model for 
performance analysis in which test cells are 
transported over an agreed virtual 
connection. The O.191 measurement tests 
performance on a cell-by-cell basis in the 
ATM layer.  

The function and performance of other payload types must be considered separately. 
For example, the payload type for Channel B will be fixed. 

Note: If you select AAL-0 as the payload type, you can select a PRBS pattern as the 
payload data. 

The Test Cell Format standard is '97 Format. For example, this format is backward 
compatible with the ANT-20 Broadband Analyzer/Generator module. The ’95 Format 
is backward compatible with equipment that uses legacy applications. 
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6.5.2 AAL-5 Setup 

If AAL-5 was set as the Payload Type on the Header Setup, additional parameters 
must be set.  

6.5.2.1 AAL-5 Trailer TX 

Sets the AAL-5 trailer information.  
Enter the User to User Indication (UU) and 
Common Part Indicator (CPI) bytes.  Specify 
the two-byte trailer length. 
 
The graphic below outlines the AAL-5 
structure. 

 

 

6.5.2.2 AAL-5 Payload Setup Tx  

Sets the Payload Type.  If you select Pattern 
as the payload type, select the Pattern type; if 
you select IP stacks, select the stack type. 
The number in parenthesis is used to identify 
the stack in the overview. 
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6.5.3 AAL-2 Setup 

If AAL-2 was set as the Payload Type on the Header Setup, additional parameters 
must be set. 

6.5.3.1 AAL-2 Channel select TX 

Specifies which AAL-2 channel(s) should be 
active. CID D on the TX side is the 
background channel.. 
 

 

6.5.3.2 AAL-2 Traffic Profile TX 

Specifies the traffic profile. The “max. Value” 
is displayed in the selected “Units,” in this 
case in bits per second (Bit/s). 

 
The AAL-2 Setup screen specifies additional 
AAL-2 settings. 
The selections vary depending on the “SAP” 
selected. 
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6.5.3.3 AAL-2 Channel Setup 

Specifies additional AAL-2 settings. 
Select the SAP (service access point) type. 
Select the CID, LI. The other selections vary 
depending on the SAP type. Set the UU, then 
enter the CI and LP. Set the trailer length. 
The selections vary depending on the “SAP” 
selected, as outlined in the graphic below. 

 

 

6.5.3.4 AAL-2 Payload Setup Tx  

Sets the Pattern used as the payload for 
each channel. 

 

6.6 Configuring Channel Explorer 

6.6.1 Enabling the Channel Explorer 

Select the  tab to display the 
Measurement Selection page. Select 
Channel Explorer to enable the ATM 
explorer. 
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6.6.2 Configuring Explorer Channels 

Select the  tab to display the 
Channel Explorer Setup page. Type 
the channel ranges for which the 
Explorer displays results. In this 
example, the Explorer displays the 
VPI channels 0–255, and within each 
VPI channel, it displays the VCI 
channels 0–65535. 

 

6.7 Traffic Analyzer 

The Traffic Analyzer is very similar to the Channel Explorer. The difference in the 
Channel Explorer and the Traffic Analyzer is that the Traffic Analyzer provides real-
time results. 

Note: Traffic Analyzer is part of the “ATM Enhanced” option. 

6.7.1 Enabling the Traffic Analyzer 

Select the  tab to display the 
Measurement Selection page. Select 
Traffic Analyzer to enable the traffic 
analyzer. 
On the ATM structure page, the RX 
line now ends with the UNI/NNI block 
and a “Scan” block appears. The 
“Scan” block indicates that the 
Channel Traffic Analyzer mode is 
running and no PRBS measurements 
can be done on a specific ATM 
channel. 

6.7.2 Configuring Traffic Analyzer Channels 

Select the  tab to display the 
Traffic Analyzer Setup page. Type the 
channel ranges to be analyzed. In this 
example, the Explorer displays the 
VPI channels 0–255. 

 



 Asynchronous Transfer Mode – ATM 

  ANT-5 Page 117 

6.8 ATM Setup Summary 
The ATM Setup Summary page 
displays the parameters that have 
been selected for testing. 

 

 

6.9 IMA Monitor 

Inverse Multiplexing for ATM (IMA) is governed by the ATM Forum. IMA devices 
divide an aggregate stream of ATM cells across multiple cost effective T1/E1 (1 – 32) 
links on a cell by cell basis. The main advantages of IMA are reduction of cost, fault 
tolerance, traffic management and link control. 

 

IMA defines two new types of OAM cells, the filler cells and the ICP cells. The filler cell 
(53 bytes) is used for rate decoupling at the IMA sublayer. The ICP cell (53 bytes) 
contains information about the IMA link and is available on each link belonging to the 
group. 
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6.9.1 Enabling the IMA Monitor 

Select the  tab to display the 
Measurement Selection page. Select 
IMA Monitor to enable the IMA 
monitor. 

Note: This selection requires the “IMA Monitor” option. 

The IMA Monitor looks at the ICP cells and reports statistics in the IMA Summary and 
IMA Link results panes. 

6.10 Ping 

Note: Ping requires the “ATM Ping” option. 

6.10.1 Enabling Ping 

Select the  tab to display the 
Measurement Selection page. Select 
Ping to enable Ping transmit, Reply to 
Ping to enable Ping reply, or Trace 
Route to enable trace route.  These 
selections are only available if the 
AAL-5 payload is set to IP Stack. 

6.10.2 ICMP Setup 

Select the  tab to display the ICMP 
Setup page. 
Enter the Source and Destination 
addresses for the IP connection. 
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Additional ICMP settings must be specified, and can be found in additional menus. 
These additional menus can be viewed by selecting a category from the “View” drop-
down menu.  The following table defines which settings apply for the different 
applications. 

 Ping Reply to Ping Trace Route 
 IP Connection 
Source Address 9 9 9 
Destination Address 9 8 9 
ICMP Data 
Data 9 8 c 9 
Packet size 9 8 c 9 
Ping Profile 
Mode 9 8 8 
Number of pings 9 8 8 
Pause 9 8 8 
IP Settings 
TTL 9 9 8 
TOS 9 8 c 9 
Don't fragment 9 8 c 9 
Limits 
Timeout 9 8 9 
Trace Route 
Start TTL 8 8 9 
Max. hops 8 8 9 
c The values are taken from the incoming ICMP Echo Request message. 

 

Select ICMP Data from the drop-down menu.  Enter the Data byte. This is used as 
payload inside the ICMP message.  Enter the Packet size.  This is the size of the 
ICMP message. Since ICMP uses an 8-byte header, the number of transmitted data 
bytes is (Packet Size – 8).  

Select Ping Profile from the drop-down menu. Select either Multiple (number of 
pings) or Continuous Mode.  If you selected Multiple, enter the Number of pings to 
be sent out, and the time to Pause between each message. 

Select IP Settings from the drop-down menu.  Set the time to live (TTL), Type of 
Service, and whether to set the Don’t Fragment flag in the IP header. 

Select Limits from the drop-down menu. Set the Timeout, in seconds.  This is the 
amount of time to wait before timing out. 

Select Trace Route from the drop-down menu. Set the Start TTL. This is the initial 
time to live used in the first outgoing packet. (This can be used to set the start offset 
for the Trace Route algorithm.)  Enter the maximum number of hops.  
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6.10.3 Activating a ping test 

Ping is an automatic measurement sequence. Pressing the  Button activates 
the ping measurement. When running a ping test, the transmitter sends out a ping 
request packet to which the destination (target) responds by sending a response 
packet. Ping tests tell you if the destination is alive and awake, how fast the ping went 
to the destination and back to the receiver, and if ping packets were dropped and lost 
along the way. 

If the mode is set to continuous, ping stops either after the measurement time is 
reached or when the measurement is stopped manually. 

6.11 ATM Results 

The results screens are selected by pressing the Results function key.  

6.11.1 Results Summary 

The left half of the screen displays the 
large OK, as long as there are no 
defects or anomalies recorded. If any 
defects or anomalies occur during a 
test, the large OK is replaced by a list 
of continually updated defects and 
anomalies that have been detected by 
the instrument during the test. 

 

6.11.2 Injection of ATM Anomalies and Defects 

Before anomalies or defects can be 
injected, check that the following 
parameters are set. 
1. Ensure that Channel A is checked 

and Traffic On has been selected. 
See section 6.4. 

2. Ensure that the value of the PCR 
is greater than zero. See section 
6.4.3. 

 

To inject an anomaly or defect into the Tx path, press the Actions firm key, and then 
select either ATM Defect allowing the injection of VC-AIS, VC-RDI, VP-AIS and 
VP-RDI defects. Alternatively, select ATM Anomaly allowing the injection of HCOR, 
HUNC, Cell Error and Cell Loss anomalies. If you are using AAL-2 or AAL-5, 
applicable anomalies can be injected. 
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Once the parameters are set, press the Inject firm key. The Inject firm key will now be 
depressed and the injection icon, , displays an animated syringe when defects or 
anomalies are injected. To stop injecting, press the Inject firm key, the injection icon 
now disappears. 

The Inject firm key appears automatically in the Injection page. To allow injection 
from any other page, users can view the Inject firm key by pressing the Alt button. 

6.11.3 ATM Cell Statistics 

The ATM Cell Statistics page 
displays information relating to cells 
received on the receiver Rx. Details of 
the statistics are given below and 
related to the associated graphic. 
HCOR or HUNC shows if cells have 
been received which contain 
correctable or uncorrectable header 
errors. 

 

The Link  
• Total is the number of cells received 

• Load is the number or percentage of cells that contains user information, including 
OAM cells 

• Idle/Unassigned is the number or percentage of cells received 

• CLP =1 Count of cells where CLP=1. If congestion causes a problem, the network 
will discard these cells first 

• OAM is the number or percentage of cells that are used for network management 
purposes. 

The Specific ATM Path/Channel under test 
• VPI and VCI shows the path and channel of the cell under test 

• Filtered shows the number or percentage of cells which match the selected 
VCI/VPI. This value is with reference to the total value. 

• CLP =1. Count of cells where CLP=1. If congestion causes a problem, the network 
will discard these cells first which match the VCI/VPI 

• OAM is the number or percentage of cells that have been used for network 
management purposes that match the VCI/VPI. This value is with reference to the 
number of filtered cells. 
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6.11.4 ATM Load Statistics 

The ATM Load Statistics page 
displays information relating to the 
ATL load. Details of the statistics are 
given below and related to the 
associated graphic. 
HCOR or HUNC shows if cells have 
been received which contain 
correctable or uncorrectable header 
errors. 

 

The Link  
• Total is the number of cells received 

• Load is the number or percentage of cells that contain user information 

The Specific ATM Path/Channel under test 
• VPI and VCI shows the path and channel of the cell under test 

• Total is the number of cells received on this channel/path 

• PCR is the peak cell rate 

• Current is the actual, current load 

6.11.5 ATM 1-pt CDV CIT 

The ATM 1-pt CDV CIT page displays 
information relating to the 1-point cell 
delay variation and the CIT (Cell 
Interarrival Time. The distance 
between two ATM cells.).
For the CDV, the minimum and 
maximum are reported. 
For CIT, the minimum, maximum, and 
mean (average) are reported. 
HCOR or HUNC shows if cells have 
been received which contain 
correctable or uncorrectable header 
errors. 

 



 Asynchronous Transfer Mode – ATM 

  ANT-5 Page 123 

6.11.6 AAL Results 

6.11.6.1 AAL-5 Statistics 

The AAL-5 statistics page reports the 
current (Curr. Rate), average (Aver. 
Rate) and count of Bandwidth 
Frames and Bytes.  In addition, it 
reports the current and last values 
for the CPI, UU, and length. 

 

6.11.6.2 AAL-2 Statistics 

The AAL-2 Summary page reports the 
current (Curr. Rate), average (Aver. 
Rate) and count of Bandwidth 
Frames and Bytes.  In addition, it 
reports the current and last values 
for the CPI, UU, and length. 
The display can be changed from 
Bandwidth/Bytes to Packets. 

 

6.11.7 ATM Quality of Service 

The ATM Quality of Service page 
shows the results of the QoS test as 
defined in ITU-T Recommendation 
I.356. 

 

Delay measurements include:  
1. Cell transfer delay CTD, is the time between t2 and t1 of the test cell where: 

• t1 = the time the cell enters the device under test 

• t2 = the time the cell leaves the device under test 
2. Cell delay variation CDV, is the degree of variation in the CTD of the virtual 

connection. By defining the QoS it is possible to offer different levels of service, for 
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example, by offering different guaranteed maximum cell loss rates. This gives 
service providers a means for structuring the changes made for the service, but 
also, the service provider must be able to demonstrate the QoS to ITU-T O.191. 

Cells exceeding the specified maximum delay are assumed to be of significantly 
reduced value to the application. 

6.11.8 Viewing Results from the Channel Explorer 

The Channel Explorer lists results for 
channels on which the ANT-5 
conducts tests. You can scroll down 
the entire list of channels, or type 
channel numbers in the VPI and VCI 
text boxes. If you type the number of 
a channel that is not available, the 
Explorer lists the next lowest channel. 
The time stamp indicates the most 
recent time a VPI/VCI channel was 
detected.  

6.11.9 Viewing Results from the Traffic Analyzer 

The Channel Traffic Analyzer (CTAN) 
lists results for channels on which the 
ANT-5 conducts tests. The time 
stamp indicates the most recent time 
a VPI/VCI channel was detected. 

 
Select SET to specify the units of 
measure, sort method, and column 
sequence. 

Note: For the payload type (PTYP), 
only AAL-5 and AAL-2 can be 
detected. 

 

 

When the CTAN is started, it will gather the channels and analyze the traffic in real 
time. If the number of channels exceeds the limit of CTAN an “overflow” message will 
appear. 
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6.12 ATM anomaly and defect results 

6.12.1 Defect Panel 

The Defect Panel view lists the ATM 
defects, namely LCD, VC-AIS, 
VC-RDI, VP-AIS and VP-RDI defects. 
If you are using AAL-2 or AAL-5, 
applicable defects will also be 
reported here. The defect panel 
continually updates, displaying active 
events in red. The defect panel LED’s 
turn yellow during a test to show 
historic alarms, that is, defects that 
have been raised during a test but are 
not currently active. To reset the 
LEDS press Alt and Menu and select 
System >LEDs >Reset LEDs. 

 

Note 1: PLM, UNEQ and TIM alarms are associated with G.832 framing in PDH E3 or 
E4 mode. If these alarms are generated the HP soft led situated at the top of the 
screen will light up.  

Note 2:The CTM (Cell Type Mismatch) LED indicates whether the OAM type received 
matches the type specified in the receiver setup. 

6.12.2 Event Log 

The Event Log view lists ATM events 
in time order as they occur during a 
test, including start-time, stop-time 
and duration of the defect or total 
anomalies per second. If you are 
using AAL-2 or AAL-5, applicable 
events will also be reported here. 
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6.12.3 Anomaly count 

The Anomaly Count view lists the 
ATM anomalies in hierarchical order 
which are relevant to the current test. 
The number of anomalies occurring 
during a test are counted for each 
anomaly type, and the ratio of each 
anomaly within the elapsed period of 
test is displayed. If you are using 
AAL-2 or AAL-5, applicable anomalies 
will also be reported here. 

 

6.12.4 Graphs 

The Graph view displays a graphical 
timeline representation of ATM 
anomalies or defects that have been 
detected during the test. The bar 
displayed indicates that an event was 
detected during the time interval. If 
you are using AAL-2 or AAL-5, 
applicable anomalies or defects will 
also be reported here. 
The list of anomalies or defects is 
shown on the left of the chart and can 
also be scrolled vertically if required. 
Refer to section 4.4.4.4, Graphs, for 
an example on how to use the 
detailed zoom feature. The benefit of 
the zoomed feature is it allows time to 
be shown in different units for 
maximum effect. 

 

6.13 IMA Results 

The IMA results are divided into two main 
categories: Summary and Link Status. 
For Link Status, there are two types: 
Link Summary and Link Status for a 
group of 8 links. 
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6.13.1 IMA Summary Results 

The IMA Summary view lists the IMA 
results which are relevant to the 
current test.  
During the test, the result will turn 
white if there is a change in status. 

 

6.13.2 IMA Link Summary 

The IMA Link Summary view lists the 
IMA status for all of the 32 links. 
During the test, the channel number 
or link status will turn white if there is 
a change in status. In this example, 
link 0, 1, and 2 are active; all other 
channels are “Not in Group,” meaning 
not active. 
Red indicates there was a defect 
during the measurement. On link 2, 
there is an actual defect at the 
moment. White indicates there was a 
status change on this link during the 
measurement, meaning it is different 
from the sample captured at the start 
of measurement. “Tx # Rx” indicates 
that the transmit and receive status 
are not the same.  To view more 
detail, select IMA Link (0-7) Status. 

 

6.13.3 IMA Link Status 

The IMA Link Status view lists the 
IMA status, in detail, for 8 links. The 
numbers in parenthesis identify which 
links are listed. 
The TX state, RX state, and any 
defects are listed. 
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6.14 Ping Results 

6.14.1 Ping List 

The Ping List view lists all of the ping 
events.  
The “Message” column is used to give 
a little bit more information what 
happened. Internal states and the 
ICMP type and code field are taken to 
generate this message. 
The capacity of the ping list is limited 
to 270 entries. If the limit is reached, a 
“List overflow” message is displayed.  

6.14.2 Ping Statistics 

The Ping Statistics view lists the 
number of ping packets sent, 
received, lost, and number of 
unknown packets.  It also lists the 
max, min, and average delay. 

 

6.14.3 Ping Stack Errors 

The Ping Stack Errors view lists any 
errors that caused a problem in the 
stack. 
If the “ICMP Error” or “Stack Error” is 
illuminated this page can give helpful 
additional information to see what 
went wrong. 
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6.14.4 Trace Route Results 

The Trace Route view lists all of the 
hops found in the trace. 
The capacity of the Trace Route list is 
limited to 90 entries. If the limit is 
reached a “List overflow” message is 
displayed. 

 

6.15 ATM LED Indicators 

The sixteen on-screen LEDS relevant to ATM testing are arranged as shown below: 

 

LOS Loss of Signal Lof/Oof Loss of Frame 

RS/MS Regen / Multiplex Sections Bx Section or path error monitor 

AU Administrative Unit Fas/Crc FAS / CRC Error 

HP High Order Path LP Low Order Path 

TU Tributary Unit ATM VP Virtual Path alarm 

P-RDI Path Remote Defect Ind. ATM VC Virtual Channel alarm 

P-AIS Path AIS LCD Loss of Cell Delineation 

TSE Test Sequence Err. (Bit Err.) LSS Loss of Sequence Sync. 

6.16 Further reading 

A useful resource is JDSU’s ATM Pocket Guide. (Literature order number: 
TP/EN/PG04/0400/AE Repl. 1020.) This guide introduces the basics of ATM and gives 
some details on various measurement methods. 
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7. Troubleshooting 

7.1 Self-test failure 

When the ANT-5 is switched on, it automatically runs a self-test sequence which runs 
from left to right across the screen and indicates the progress through the test. If the 
progress bar stalls at any point please refer to Section 8, Customer support, and 
contact the nearest JDSU Sales Office or Technical Assistance Centre. 

Note: When the battery charge is very low, it may be possible for the ANT-5 to switch 
on but fail to complete its self-test procedure before automatically switching off due to 
the low battery. This is not a self-test failure and can be corrected by charging the 
battery. 

7.2 No screen image 

If the screen shows no image and no backlight, it may have turned itself off in order to 
save battery power. If this is the case the screen LED ( ) should be on to indicate 
that the screen has been blanked. The full screen display can be restored by pressing 
any key. See Section 2.13, Power saving features. 

If the screen shows no image with the backlight on, it is possible that the LCD contrast 
needs adjustment. See Section 2.6.1, Adjusting the screen contrast. 

7.3 No beep when the storage card is inserted 

If the ANT-5 does not beep when a storage card is inserted, then the following should 
be checked: 

• The card is firmly inserted and correctly seated in the slot. 

• If a CompactFlash card has been used, ensure that it has been formatted with an 
MS-DOS compatible file system. If the card can be read normally by a PC with a 
suitable slot, then it is possible that there is a problem with the ANT-5. See Section 
3.2.6. 

If the failure continues please refer to Section 8, Customer support, and contact the 
nearest JDSU Sales Office or Technical Assistance Centre. 

If it is necessary to send the ANT-5 for repair, the storage card should be included if 
possible. 

7.4 Screen dump fails 

If a screen dump fails to be saved in a file or sent to the serial port, the Screen Dump 
feature may have been set to DISABLED in the Printer section of the System menu. 
The settings used for the other parameters in the Printer and Serial Port sections 
should also be checked. 
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7.5 Errors caused by poor optical connections 

Unexplained errors may be caused by poorly aligned or dirty optical connectors. If this 
problem is suspected, remake the optical connections as follows: 

.  
WARNING: Invisible laser radiation. 

Note: Read the safety information in Section 1.5.3, Laser safety, before proceeding. 

1. Deactivate the ANT-5 laser source (Tx), by clearing the Laser On checkbox in the 
Interface Setup Tx panel. See Section 4.3.1.2 for further details. 

2. Deactivate the incoming laser source connected to the Rx connector of the ANT-5. 
3. Unscrew each patch lead and lift it away to break the connection. 
4. Clean the ANT-5 connectors and patch lead connectors by an approved method 

such as those outlined in Section 1.5.4, Cleaning optical connectors. 
5. Holding the ANT-5 in a vertical position with the rear connectors facing upwards, 

carefully locate and screw on the patch lead connectors making sure that each 
locating lug is in the correct position and the patch lead is held straight. 

4. Re-activate the laser sources after both patch leads have been reconnected. 

7.6 Battery performance and conditioning 

If the ANT-5 battery is put through a large number of incomplete cycles of charging 
and discharging, the process of monitoring the charge level will gradually become less 
certain. The Battery Level indicator will warn of this situation by displaying the 
message ‘Reading may be inaccurate’. If this occurs, the battery conditioning 
procedure described below should be followed to re-establish the upper and lower 
limits for the charge indicator. 

7.6.1 Battery conditioning 

The battery can be conditioned by performing two full discharge/recharge cycles as 
follows: 
1. Disable the timed Auto Power-off feature in the Power Saving section of the 

Preferences menu. 
2. Discharge the battery by leaving the ANT-5 switched on with the external power 

supply disconnected. The ANT-5 will switch itself off when the battery is fully 
discharged. 

3. Reconnect the external power supply and check that the battery LED  is lit. 
4. Leave the ANT-5 switched off whilst the battery is charging. An adequate charge 

will be reached within 3 hours and the ANT-5 will automatically switch to a trickle 
charge mode when fully charged. 

5. Repeat actions 2, 3 and 4 for a second discharge/recharge cycle. 
6. Re-enable the timed Auto Power-off feature if required. 
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7.6.2 Replacing the ANT-5 battery pack 

If the rechargeable battery pack develops a fault it can be replaced locally in an 
appropriately equipped workshop where protection can be provided from 
contamination and static discharge. Replacement battery packs can be obtained from 
your nearest JDSU Sales Office or Technical Assistance Centre. 

The battery pack can be replaced as follows: 

 
WARNING: Static Sensitive. 

Note: Replacing the ANT-5 battery pack may unavoidably cause the setup information 
under the System and Preferences menus to return to their default settings. 
However, data can be retained if an external power supply is connected. 

1. Switch off the ANT-5 and disconnect all connections and the external mains power 
supply. 

2. Invert the ANT-5 so that the underside is uppermost and the front bumper is 
closest to you. Take care to protect the screen and keyboard if the ANT-5 is placed 
on a hard surface. 

3. The battery compartment is located underneath the ANT-5, just behind the front 
bumper. Access is provided by two screws at the rear edge of the battery 
compartment cover. 

4. Remove the two screws and open the cover to reveal the battery pack. Do not 
remove any other screws. 

5. Carefully lift out the battery pack and disconnect the battery cable at the plastic 
connector where it emerges from inside the ANT-5. 

6. Plug in the replacement battery pack and place it in the battery compartment.  
7. Refit the battery compartment cover. 
8. The battery pack should now be charged and conditioned as described in Section 

7.6.1, Battery conditioning. This procedure will establish the initial conditions for 
the battery charge indicator. 

7.7 Accessing test results if the unit has been powered down 

The ANT-5 will not switch itself off if a test is running. However, if the unit is 
accidentally switched off, or there is no power left in the battery, results will be saved 
in the user: device of the File Manager. These will be saved as AUTO files, with 
suffixes of .A5R; the time and date will also be present so that the results are easily 
identified. 
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8. Customer support 

8.1 Questions about JDSU products 

Any questions regarding the installation, operation, maintenance or repair of any 
product in the JDSU product range should be addressed to the nearest JDSU Sales 
Office or Technical Assistance Centre. For locality information visit our web site, 
www.jdsu.com, or contact the nearest Regional Sales Office as listed on the back of 
the manual. 

8.2 Customer Services 

Global Services and Solutions markets a broad portfolio of services including 
consultancy and training, enabling customers to aggressively build their competitive 
advantage within the markets they serve. Information can be found on our web site 
under Services or by contacting the nearest JDSU Sales Office. 

8.3 Service procedure 

If it is necessary to send the instrument for maintenance or repair, please contact the 
nearest JDSU Sales Office or Technical Assistance Centre as above. 

To assist our service engineers in responding to your enquiry, the fault which occurred 
should be fully described and a note made of the circumstances at the time and any 
error messages seen. The version information listed in Section 8.4 should also be 
included where possible. 

If possible, the original packing should be used for returning the instrument, otherwise 
suitable packaging should be used to avoid damage in transit. Insurance against loss 
or damage in transit is also recommended. 

8.4 Version information and serial numbers 

The version information and serial numbers of the instrument and application software 
can be obtained as follows: 

• The serial number of the instrument, located on its underside. 

• The hardware/software version information and electronic identity numbers can be 
displayed by pressing the Alt+Menu key, then selecting About from the Help 
menu. 

• The version information for the SDH Access Tester application can be displayed by 
pressing the i  key from within the application. Press the Enter or Esc keys 
to remove the About screen and, if you do not want to remain in the application, 
press Alt+Esc to switch to the application launcher. 
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• The options currently installed can be displayed by pressing Menu and selecting 
Options from the Tools menu. This function can also be used to install and 
uninstall software options, which is generally carried out at a JDSU Sales Office, or 
Technical Assistance Centre.  

If required, the About screens can be saved in a file or sent to a printer on the serial 
port by pressing Alt+#. See Section 2.7, Printing the current screen. 

8.5 Software loading 

The ANT-5 is designed to provide an easy path for future upgrades and 
enhancements, not only in the form of software applications, but also by replacing the 
core software for the ANT-5 itself. 

Software will usually be supplied on a CD ROM, although other formats may also be 
employed in the future. To load any software into the ANT-5, refer to the instructions 
supplied with the software media. 

8.5.1 Deleting software applications 

!
 

WARNING: Do not do this unless you intend to delete an application.  

Software applications can be deleted by highlighting the appropriate icon in the 
application launcher screen and pressing Alt+Del (press Del whilst holding the Alt key 
down). Next time the ANT-5 is switched on it will run a purging routine to reclaim the 
memory which has been made available. 
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9. Appendix A – Specifications and ordering information 

Note: These specifications are valid under the nominal operating conditions, unless 
otherwise stated. Error limits are stated as operating errors or as intrinsic errors and 
variations, these terms being as defined in IEC 359. 

9.1 General 
Serial port 9-way, male, D-type connector 
CompactFlash card slot Single, standard CompactFlash Card 
Supported CompactFlash cards  Types I & II 
Dimensions (L×W×H) approx. 275 mm × 197 mm × 76 mm 

(10.95" × 7.9" × 3") 
Weight approx. 2.2 kg (4.85 lb) 

9.2 External Power Supply 
Type PPS-2 
Input 100-240 V, 1.6A, 47/63 Hz, AC 
Output 19 V, 3 A, DC 

Note: The PPS external power supply is supplied with an integral DC cable and a 
separate AC mains cable. The country of use must be specified when ordering the 
mains cable so that the correct plug is supplied. 

9.3 Environment 
Storage temperature -20°C to +60°C (-4°F to +140°F) 
Battery charging temperature +5°C to +30°C (41°F to +86°F) 
Operating temperature +5°C to +45°C (41°F to +113°F) 
Condensation Occasional short-term condensation is 

allowed but performance is not 
guaranteed 

Humidity Continuous operation in hot, humid 
climates is not guaranteed 
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9.4 Electrical and Mechanical 

9.4.1 G.703 Transmitters 

Interface  ITU-T G.703 
BNC (unbalanced) 75Ω Connectors and Impedance 

RJ-48 (2048 kbit/s 
balanced) 

120Ω 

Bit rate  2048, 34368, 44736, 
51840, 139264, 
155520 kbit/s 

Line code  CMI, B3ZS, HDB3, AMI 
Clock source SDH hierarchy Internal, From Rx, Ext. 

Data 2048 kbit/s, Ext. 
Clock 2 MHz, Ext. Data 
1544 kbit/s, Ext. Clock 1.5 
MHz 

 PDH hierarchy Internal, From Rx, Ext. 
Data 2048 kbit/s, Ext. 
Clock 2 MHz, Ext. Data 
1544 kbit/s, Ext. Clock 1.5 
MHz 

Isolation, BNC and RJ-48  for connection to SELV 
circuits only 

9.4.2 G.703 Receivers 

Interface  ITU-T G.703 
Connectors and Impedance BNC (unbalanced) 75Ω 
 RJ-48 (2048 kbit/s 

balanced) 
120Ω 

Bit rate  2048, 34368, 44736, 
51840, 139264, 
155520 kbit/s 

Jitter performance  To ITU-T G.823 G.824 for 
DS3, G.825 for SDH 

Line code  CMI, B3ZS, HDB3 
Isolation, BNC and RJ-48  for connection to SELV 

circuits only 

9.4.3 Protected Monitor Point  

PMP -20 dB to -26 dB linear attenuation to ITU-T G.772. ANT-5 is fully compliant with 
ITU-T G.772, sections 2.2 and 3.2 (PMP incorporated in transmission equipment). 
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Compliance with sec 2.3 and 3.3 (PMP between transmission equipment) is achieved 
subject to the following conditions: 

Bit errors may be encountered when √f and jitter are both at their maximum permitted 
values. In addition the following precautions should be taken: 

The ANT-5 should be allowed to stabilise to an ambient temperature for a period of 5 
minutes before any measurements are taken. 

For E3, root-f between 0 ≤ attenuation ≤ 6 dB (max) is permitted. 

Performance at E1, E3 and DS3 extends to –26 dB (linear attenuation) for full 
compatibility with older types of transmission equipment. 

9.4.4 G.957 Optical Transmitter and Receiver 

The following only applies if optical interfaces are fitted: 
Connector FC/PC 
Line code scrambled NRZ 
Transmitter wavelengths 1310 nm and/or 1550 nm (Depending on optical 

option fitted) 
Line bit rates 155.52 Mbit/s 622.080 Mbit/s 2488.32 Mbit/s 

(Depending on optical option fitted) 
Receiver wavelength range 1100 nm to 1580 nm 

9.4.5 Optical Output and Input levels 

Optical transmitter specifications: 
Optical Option 
 

Line rate 
 

Wavelength 
 

Tx Output power 
@ 1310nm 

Tx Output power 
@ 1550nm 

BN4565/00.01  STM1  1310SR -8dBm to -15dBm  
BN4565/00.03 STM1 1310SR/1550LR -8dBm to -15dBm +2dBm to -4dBm 
BN4565/91.13 STM1/4 1310SR -8dBm to -15dBm  
BN4565/00.14 STM1/4 1310SR/1550LR -8dBm to -15dBm +2dBm to -4dBm 
BN4565/91.15 STM1/4 1310LR/1550LR +2dBm to -4dBm +2dBm to -4dBm 
BN4565/91.16 STM1/4/16 1310LR/1550 LR +3dBm to -3dBm +3dBm to -3dBm 
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Optical receiver specifications: 
Optical Option 
 

Line rate 
 

Wavelength 
 

Rx Dynamic range 
@ 1100 to 1600nm 

Rx Optical  
overload 

BN4565/00.01  STM1  1310SR -8dBm to -28dBm N/A 
BN4565/00.03 STM1 1310SR/1550LR -8dBm to -28dBm N/A 
BN4565/91.13 STM1/4 1310SR -8dBm to -28dBm N/A 
BN4565/00.14 STM1/4 1310SR/1550LR -8dBm to -28dBm N/A 
BN4565/91.15 STM1/4 1310LR/1550LR -8dBm to -28dBm N/A 
BN4565/91.16 STM1/4/161 1310LR/1550 LR -8dBm to -28dBm -6dBm 

 

9.4.6 ECL NRZ monitor specifications 

Connector SMA, unbalanced (coaxial) 
Impedance AC Coupling, 50Ω 
Line code NRZ (scrambled) 
Bit rate 155.52 Mbit/s, 622.08 Mbit/s, 

2488.32 Mbit/s 
Input voltage range (peak to peak) 200 mV to 1 V 

9.4.7 PDH T1 Interface 

Connector Bantam, balanced 
Input impedance 100 Ω 
Bit rate 1.544 Mbps 
Line codes AMI, B8ZS 

9.4.8 External Clock 

Connector BNC (unbalanced) 75Ω 
Input External Data 1544 kbit/s, External Clock 

1.5 MHz 
External Data 2048 kbit/s, External Clock 
2 MHz 

                                            

1 PMax for receivers on STM16 units is -6dBm. 
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9.5 Specification and features of the SDH Access Tester application 

9.5.1 SDH STM-1 Mappings – base software 

Containers C-12, C-11, C-3, C-4 
Administrative Units AU-4 

9.5.2 Timers 

Manual User start / stop 
Timed User start, stop after pre-defined duration 
Automatic Start at pre-defined time, Stop after pre-

defined duration 

9.5.3 Storage 

Measurement results and instrument configuration can be stored in non-volatile 
memory or on the storage card. The amount of storage depends on the size of card 
used. Results can also be sent to a printer or exported to a PC. 

9.5.4 Test Patterns 

Test patterns may be executed on any of the provided bit rates either directly at the 
SDH interface or within the STM-n substructure. ITU-T & Non ITU-T. 

PRBS 211-1, 215-1, 220-1, 223-1, 231-1 
Inverted PRBS (IPRBS) 211-1, 215-1, 220-1, 223-1, 231-1 

QRSS20 

Programmable 16-bit digital word 

Traffic (Rx only) 

The Traffic pattern should be selected if the incoming signal is expected to contain 
network traffic. Selecting this option effectively disables the pattern detection process 
and the reporting of LSS defects. 

9.5.5 Defects and Anomalies Monitoring 

All anomalies and defects for STM-n, E4, DS3, E3 and E1 

For 2048 kbit/s, PCM30, PCM30C, PCM31 and PCM31C framing supported 
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9.5.6 Defects and Anomalies Injection 

All defects and anomalies may be injected 

Single, Rate or Continuous injection 

LEDs and beeper for audible/visual notification 

9.5.7 Overhead Analysis and Injection 

The following bytes within SOH and POH may be analysed and injected: 

C2, D1, D2, D3, D4, D5, D6, D7, D8, D9, D10, D11, D12, E1, E2, F1, F2, F3, G1, J0, 
J1, J2, K1, K2, K3, K4, M1, N1, N2, S1, V5, Z1, Z2. 

The following bytes within SOH and POH may be analysed but NOT injected: 

A1, A2, B1, B2, B3, H1, H2, H3, H4, Y. 

9.5.8 Performance Analysis 

PDH Rates G.821, G.826, M.2100 
SDH STM-n G.826, G.828, G.829, M.2100, M.2101 
SONET ANSI 

9.6 Optional Accessories 

The range of optional accessories available for the ANT-5 includes a shoulder bag, 
neck strap and hard carrying cases. Please contact the nearest JDSU Sales Office or 
Technical Assistance Centre for the latest information. For locality information visit our 
web site, www.jdsu.com, or contact the nearest Regional Sales Office as listed on 
the back of the manual. 

9.6.1 Hardware options and order numbers 

Option  Order Number 
STM-1 1310 SR 4565/00.01 
STM-1 1310 SR/1550 LR 4565/00.03 
STM-1/-4 1310 SR 4565/91.13 
STM-1/-4 1310 SR/1550 LR 4565/00.14 
STM-1/-4 1310 LR/1550 LR 4565/91.15 
STM-1/-4/-16 1310 LR/1550 LR 4565/91.16 

9.6.2 Cables 

Balanced E1 Cable RJ-48 / 2xCF K1597 
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For the serial port, a serial printer cable (K1524), modem cable (K1550) and null 
modem cable (K1619) are available. See Appendix C – Serial port and adapter 
cables. 

9.6.3 CompactFlash Cards 

Optional CompactFlash card 16 Mbyte + 
adapter 

BN 4548/00.42 

9.7 Ordering information 

Please contact the nearest JDSU Sales Office or Technical Assistance Centre. For 
locality information visit our web site, www.jdsu.com, or contact the nearest Regional 
Sales Office as listed on the back of the manual. 

9.8 Upgrade information 

To receive information on available upgrades, contact the nearest JDSU Sales Office 
or Technical Assistance Centre. For locality information visit our web site, 
www.jdsu.com, or contact the nearest Regional Sales Office as listed on the back of 
the manual. 

Note: When purchasing further items to expand existing hardware and software, some 
identification details may be required. Refer to Section 8.4, Version information and 
serial numbers, for further information. 
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10. Appendix B – Standards Compliance 

10.1 Electromagnetic Compatibility 

This instrument meets the following standards for electromagnetic compatibility: 

• EN 61326: 1997 - Electrical Equipment for Measurement, Control, and Laboratory 
Use—EMC Requirements: 

• EN 61000-3-2: 1995 — Harmonic Current Emissions 

• EN 61000-3-3: 1994 — Voltage Fluctuations/Flicker 

• EN 61000-4-2: 1995 — Electrostatic Discharge Immunity 

• EN 61000-4-3: 1995 and ENV 50204: 1996 — Radiated Electromagnetic Field 
Immunity 

• EN 61000-4-4: 1995 — Electrical Fast Transient/Burst Immunity 

• EN 61000-4-5: 1995 — Surge Immunity 

• EN 61000-4-6: 1996 — Conducted Radio-Frequency Immunity 

• EN 61000-4-11: 1994 — Voltage Dips and Interruptions 

• EN 55022 (CISPR 22): 1994 with Amendments Al and A2 — Limits and Methods of 
Measurement of Radio Disturbance Characteristics of Information Technology 
Equipment: 

• EN 55022 (CISPR 22): 1994 — Radiated Emissions -Class B 

• EN 55022 (CISPR 22): 1994 — Conducted Emissions -Class B 

• Title 47 of the CFR, Part 15, Subpart B for a Class B Digital Device: 

• Section 15.107 (a) — Conducted Emissions 

• Section 15.109(a) — Radiated Emissions 

• ICES-003 Issue 3 Interference Causing Equipment Standard for Digital Apparatus: 

• From the Industry Canada Electromagnetic Compatibility Advisory Bulletin 
entitled, “Implementation and Interpretation of the Interference-Causing 
Equipment Standard for Digital Apparatus, ICES-003” (EMCAB-3, Issue 2, July 
1995): “At present, FCC and ICES technical requirements are essentially 
equivalent. Therefore, if you have FCC approval (either by meeting Part 15 of 
the FCC Rules or CISPR Publication 22), the only additional requirements are: 
to attach a note to the report of the test results for FCC compliance, indicating 
that these results are deemed satisfactory evidence of compliance with ICES-
003 of the Canadian Interference-Causing Equipment Regulations; to maintain 
these records on file for the requisite five year period; and to provide the device 
with a notice of compliance in accordance with ICES-003.” 

This device complies with Part 15 of the FCC Rules. Operation is subject to the 
following two conditions: (1) this device may not cause harmful interference, and 
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(2) this device must accept any interference received, including interference that may 
cause undesired operation. 

10.2 Safety 

The instrument complies with the safety objective of: 

• UL 60950, 3rd Edition – Safety of Information Technology Equipment 

• CSA C22.2 No. 60950, 3rd Edition – Safety of Information Technology Equipment 

• EN 60950, 2000 – Safety of Information Technology Equipment, including Electrical 
Business Equipment 

IEC 60950, 2nd and/or 3rd Edition – Safety of Information Technology Equipment, 
including Electrical Business Equipment 

The following only applies if optical interfaces are fitted: 

.  
WARNING: Class 1 Laser Product. 

10.3 R&TTE Directive 

Hereby JDSU declares that this SDH Tester is in compliance with the essential 
requirements and other relevant provisions of Directive 1999/5/EC. 
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10.4 EC Declaration of Conformity 
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11. Appendix C – Serial port and adapter cables 

11.1 Serial port 

The ANT-5 serial port is 9-way, male, D-type connector which is wired as a DTE. 

1

3
2

4

6

8

5

7

9

Serial port
connections (DTE)

DCD

RD

TD

DTR (+5V)

SGND

DSR

RTS

CTS

RI
 

11.2 Serial adapter cables 

A serial printer cable (K1524), modem cable (K1550) and a null modem cable (K1619) 
are available as shown below. 

1
2

8
5

4
3

6

7

4
2

7

6
5
3

8

20

25 pin male
Connects to
Printer (DTE)

9 pin female
Connects to
ANT-5 (DTE)

DCD

RD

TD

DTR

DSR

CTS

SGND

RTS

RTS

TD

RD

CTS

DSR

DTR

SGND

DCD

Printer cable K1524
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1
2

8

5
4
3

6
7

8
3

4

7
20
2

5

6

9 22

DCD

RD

TD

DTR

DSR

CTS

SGND

RTS

RI

DCD

RD

TD

DTR

DSR

CTS

SGND

RTS

RI

9 pin female
Connects to
ANT-5 (DTE)

25 pin male
Connects to

Modem (DCE)

Modem cable K1550

 

2
3

8

1
4
5

6
7

3
2

8

1
6
5

7

4

9 9

RD

TD

SGND

DTR

DSR

CTS

DCD

RTS

TD

RD

SGND

DSR

DTR

RTS

DCD

CTS

9 pin female
Connects to
ANT-5 (DTE)

9 pin male Connects
to

PC (DTE)

Null modem cable K1619

 

11.3 Serial-to-parallel adapter cable 

A serial-to-parallel printer cable, K1589, is available to convert the serial output from 
the ANT-5 for use with parallel printers. It comes with a 9-way to 25-way adapter. It is 
advisable to connect the printer cable to the ANT-5 before switching the unit on. 

This cable has a number of internal jumper settings which must be configured by the 
user prior to use. These settings must match the settings in the Serial Port section of 
the System menu. The jumpers are accessible by removing the four securing screws 
in the headshell; further details are supplied with the cable. K1589 has been tested 
with the HP DeskJet 320 printer in the following configuration: 

Baud Rate 19200  Parity NONE  Stop Bits ONE 
Word Length 8 BITS  Flow Control SOFT    

Note: Cable K1589 is classified as Limit A according to EN55022. 
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11.4 RJ-48 Connector 

1

3
2

4

6

8

5

7

RJ48 Connector

RXT

RXR

RXG

TXT

TXR

Not used

Not used

RXG

XT=Tip, XR=Ring and XG=Ground 
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12. Appendix D – SDH, SONET, and PDH information 

12.1 SDH structure for ANT-5 

 

 

12.2 SONET structure for ANT-5 
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12.3 SDH defect hierarchy 

Regenerator
Section

Multiplex
Section

Higher Order
Path

Lower Order
Path

LOS/LOF
J0RS-TIM

BIP Error B1

AIS

AIS

AIS

AIS

AIS

AIS

AIS

MS-AIS
MS-BIP Error
MS-REI
MS-RDI

K2
B2
M1
K2

AU-AIS
AU-LOP

HP-BIP Error
HP-REI
HP-RDI

HP-TIM
HP-UNEQ C2

J1
B3
G1
G1

TU-AIS
TU-LOP

LP-BIP Error
LP-REI
LP-RDI

LP-TIM
LP-UNEQ

LP-PLM V5
V5
V5
V5

V5
C2

J2

H4LOM
HP-PLM

Detection Generation  
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12.4 SDH Tributary Numbering 

1 321 32 1 321 321 321 32TU-12

1
1 32

1 1 2 2 2 333 444 555 666 777TUG-2

111111111111111111111TUG-3

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21VC#

111111111111111111111TUG-12

1 1 1 2 2 2 333 444 555 666 777TUG-2

1 321 32 1 321 321 321 32TU-13 1 32
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12.5 SDH Anomalies and Defects 
SDH Description Overhead Byte Intrusive 

Thru 
Mode 

LOS Loss of signal   

TSE Test sequence error (bit error)   

LSS Loss of Sequence Synchronisation   

AIS Alarm indication signal   

Regenerator Section 
OOF Out of frame A1, A2  

LOF Loss of frame A1, A2  
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B1 Regenerator section error monitoring B1 available 

RS-TIM RS trace identifier mismatch J0  

Multiplex Section 
MS-AIS Multiplex section AIS K2  

MS-RDI Multiplex section remote defect indication K2  

MS-REI Multiplex section remote error indication M1 available 

B2 (24 
bits) 

Multiplex section error monitoring B2 available 

Administrative Unit 
AU-LOP Loss of AU pointer H1, H2  

AU-NDF New data flag AU pointer   

AU-AIS Administrative unit AIS AU incl. H1, H2  

AU+PJE AU positive pointer justification event H1, H2  

AU-PJE AU negative pointer justification event H1, H2  

High Order Path 
HP-
UNEQ 

HO path unequipped C2  

HP-RDI HO remote defect indication G1  

HP-REI HO remote error indication G1 available 

HP-TIM HO path trace identifier mismatch J1  

HP-PLM HO path payload label mismatch C2  

B3 HO path error monitoring B3  

Tributary Unit 
TU-LOP Loss of TU pointer V1, V2  

TU-NDF New data flag TU pointer   

TU-AIS TU alarm indication signal TU incl. V1 to 
V4 

 

TU-LOM TU loss of multiframe H4  

TU+PJE TU positive pointer justification event H1, H2  

TU-PJE TU negative pointer justification event H1, H2  

Low Order Path 
LP-
UNEQ 

LO path unequipped V5  

LP-RDI LO path remote defect indication V5  
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LP-REI LO path remote error indication V5 available 

LP-RFI LO path remote failure indication V5  

LP-TIM LO path trace identifier mismatch J2  

LP-PLM LO path payload label mismatch V5  

BIP-2 LO path error monitoring (VC-11/VC-12) V5 available 

B3 LO path error monitoring (VC-3) B3 available 

Tandem Connection Monitoring 
HP-IEC HP incoming error count N1  

HP-ODI HP outgoing defect indicator N1  

HP-OEI HP outgoing error indicator N1  

HP-TC-
AIS 

TC alarm indication signal N1  

HP-LTC  Loss of tandem connection (i.e. loss of 
FAS) 

N1  

HP-TC-
RDI 

TC remote defect indication N1  

HP-TC-
REI 

TC remote error indication N1  

HP-TC-
UNEQ 

TC unequipped (i.e. not set up) N1  

LP-BIP LO path error monitoring (VC-12) N2  

LP-IEC LP incoming error count N1*, N2*  

LP-ODI LP outgoing defect indicator N1*, N2*  

LP-OEI LP outgoing error indicator N1*, N2*  

LP-TC-
AIS 

TC alarm indication signal N1*, N2*  

LP-LTC  Loss of tandem connection (i.e. loss of 
FAS) 

N1*, N2*  

LP-TC-
RDI 

TC remote defect indication N1*, N2*  

LP-TC-
REI 

TC remote error indication N1*, N2*  

LP-TC-
UNEQ 

TC unequipped (i.e. not set up) N1*, N2*  

*N2 in VC-12, N1 in VC-3 
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12.6 PDH Anomalies and Defects 

The following PDH Anomalies and Defects may be detected inside the SDH structure 
and at the line interface. 

DS1 Defect Description 
LOS Loss of Signal 

LOF  Loss of Frame 

AIS Alarm Indication Signal 

YELL Yellow Alarm 

DS1 Anomaly Description 
FAS Frame Alignment Signal 

CRC-6 Cyclic Redundancy Check Error 

TSE Test Sequence Error 

CODE Code Error 

DS3 Defect Description 
LOS Loss of Signal 

LOF  Loss of Frame 

OOF Out of Frame 

AIS Alarm Indication Signal (1010 payload) 

IDLE DS3 Idle (1100 payload) 

YELLOW Yellow alarm (Far End Alarm) 

LSS Loss of Sequence Synchronisation 

DS3 Anomaly Description 
FAS Frame Error 

MFAS Multiframe Error 

CP-Bit Path Parity Error 

CODE Code Error 

P-Bit Parity-Bit Error 

REI Remote Error Indication 

TSE Test Sequence Error 

E4 Defect Description 
LOS Loss of Signal 

LOF  Loss of Frame 



 Appendix D – SDH, SONET, and PDH information 

  ANT-5 Page 159 

AIS Alarm Indication Signal 

RDI Remote Defect Indication 

LSS Loss of Sequence Synchronisation 

E4 Anomaly Description 
FAS Frame Alignment Signal 

TSE Test Sequence Error 

E3 Defect Description 
LOS Loss of Signal 

LOF  Loss of Frame 

AIS Alarm Indication Signal 

RDI Remote Defect Indication 

LSS Loss of Sequence Synchronisation 

E3 Anomaly Description 
FAS Frame Alignment Signal 

TSE Test Sequence Error 

E1 Defect Description 
LOS Loss of Signal 

LOF  Loss of Frame 

AIS Alarm Indication Signal 

RDI Remote Defect Indication 

LSS Loss of Sequence Synchronisation 

E1 Anomaly Description 
FAS Frame Alignment Signal 

CRC-4 Cyclic Redundancy Check Error 

E-Bit Remote Cyclic Redundancy Check Error 

TSE Test Sequence Error 

CODE Code Error 

12.6.1 Intrusive Thru mode PDH Anomalies 

The following PDH Anomalies may be injected inside the SDH structure during 
Intrusive Thru mode testing. 

Anomaly Description 
FAS-2 Frame Alignment Signal 2 
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CRC Cyclic Redundancy Check Error 

E-Bit Remote Cyclic Redundancy Check Error 

FAS-1.5 Frame Alignment Signal 1.5 

12.7 Comparison of SDH/SONET anomalies and defects 
SDH/SONET Description 
LOS Loss of signal 

TSE Test sequence error (bit error) 

LSS Loss of Sequence Synchronisation 

LTI Loss of incoming Timer Intervals 

 

SDH (ITU-T: G.707 G.783) SONET (ANSI: T1.105) 
REGENERATOR SECTION SECTION 
OOF Out of Frame OOF Out of Frame 

LOF Loss of Frame LOF Loss of Frame 

B1(8 bits) Regenerator section error 
monitoring 

B1(8 bits) Section error monitoring 

MULTIPLEX SECTION LINE (L) 
B2 
Nx24 bits 

Multiplex section error 
monitoring 

B2 
Nx8 bits 

Line error monitoring 

MS-AIS Multiplex Section AIS AIS-L L-AIS 

MS-RDI Mux Section Remote 
Defect Indication 

RDI-L L-Remote Defect Indication 

MS-REI Mux section Remote 
Error Indication 

REI-L L- Remote Error Indication 

ADMINISTRATIVE UNIT (AU) STS – PATH (SP) 
AU-LOP Loss of AU Pointer LOP-P SP Loss of Pointer 

AU-NDF New Data Flag AU 
Pointer 

NDF-P SP New Data Flag 

AU-AIS AU-AIS AIS-P SP AIS 

AU-PJE AU Pointer Justification   

HIGH ORDER PATH (HO)   
B3 (8 bits) HO Path errors 

monitoring (VC-4) 
B3 (8 bits) SP error monitoring 
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SDH (ITU-T: G.707 G.783) SONET (ANSI: T1.105) 
HP-UNEQ HO Path UNEQuipped UNEQ-P SP UNEQuipped 

HP-RDI HO Path Remote Defect 
Indication 

RDI-P SP Remote Defect Indication 

HP-REI HO Path Remote Error 
Indication 

REI-P SP Remote Error Indication 

  PDI-P SP Payload Defect Indication 

HP TIM HO Path Trace Identifier 
Mismatch 

TIM-P SP Trace Identifier Mismatch 

HP-PLM HO Path Label Mismatch PLM-P SP Path Label Mismatch 

TRIBUTARY UNIT (TU) VT – PATH (VP) 
TU-LOP Loss of TU Pointer LOP-V VP Loss of Pointer 

TU-NDF New Data Flag TU 
Pointer 

NDF-V VP-New Data Flag 

TU-AIS TU-AIS AIS-V VP AIS 

TU-LOM Loss of Multiframe (H4) LOM Loss of Multiframe 

LOW ORDER PATH (LO)   
BIP-2 LO Path error monitoring 

(VC-12) 
BIP-2 VP error monitoring  

B3 (8 bit) LO Path error monitoring 
(VC-3) 

  

LP-UNEQ LO Path UNEQuipped UNEQ-V VT UNEQuipped 

LP-RDI LO Path Remote Defect 
Indicator 

RDI-V VP Remote Defect Indicator 

LP-REI LO Path Remote Error 
Indicator 

REI-V VP Remote Error Indicator 

LP-RFI LO Path Remote Failure 
Indicator 

LP-RFI VP Remote Failure Indicator 

  PDI-V VP Payload Defect Indicator 

LP-TIM LO Path Trace Identifier 
Mismatch 

TIM-V VP Trace Identifier Mismatch 

LP-PLM LO Path Payload Label 
Mismatch 

PLM-V VP Payload Label Mismatch 
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13. Appendix E – Performance Analysis Options 
For an application note on this topic, visit our Web Site, www.jdsu.com, or contact 
the nearest Regional Sales Office as listed on the back of the manual. 

13.1 Analysis and Hierarchy Validity 
Analysis PDH SDH SONET Appropriate Anomalies 
OFF    (none) 

G.821 x x  TSE 

G.826 (ISM)  x  B1, B2SUM, HP B3, LP BIP2/8, 
E2 FAS, E4 FAS, E3 FAS, E1 FAS, 
E1 CRC-4 

G.826 (OOS) x x  TSE 

G.828 (ISM)  x  B1, B2, TSE 

G.829 (ISM)  x  B1, B2, B3, TSE, LP-BIP 

M.2100 x x  E4 FAS, E3 FAS, E2 FAS, E1 FAS, 
E1 CRC-4, DS3 P-Bit, DS3 FAS, TSE 

M.2101  x  B1, B2SUM, HP B3, LP BIP2/8, TSE 

ANSI x x x TSE, B1, B2, B3, DS3FAS, DS3CPAR  

13.2 Summary of performance analysis standards 

The quality of digital links is determined with the aid of bit error ratio tests (BERT). The 
results of such measurements must be classified in some way, not least because the 
quality of a transmission path is often the subject of a contract between the network 
provider and the telecommunications user. For this reason an objective means of 
classifying a line as either “good” or “bad” is required. The ITU-T Recommendations 
G.821, G.826, G.828, G.829, M.2100 and M.2101 are internationally recognised 
standards that specify these parameters. 

13.2.1 Recommendation G.821 

This Recommendation was originally specified for international circuit-switched 
nx64 kbit/s connections and expanded to include higher bit rates as time went on. A 
hypothetical reference connection is the basis used for determining quality 
parameters; this comprises an international long-distance segment, a national 
segment and a subscriber access segment. 

G.821 definitions: 

• Errored second (ES): A one-second time interval in which one or more bit errors 
occurs. 
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• Severely errored second (SES): A one-second time interval in which the bit error 
ratio exceeds 10-3. 

• Unavailable second (UAS): A circuit is considered to be unavailable from the first 
of at least ten consecutive SES. The circuit is available form the first of at least ten 
consecutive seconds which are not SES. 

• Degraded minute (DM): A one-minute time interval in which the bit error ratio 
exceeds 10-6. 

• Error-free second (EFS): A one-second time interval in which no bit errors occur. 

The disadvantage of G.821 is that it relies on the evaluation of bit errors and so the 
test channel must be taken out of service to perform the measurement. 

13.2.2 Recommendation G.826 

This Recommendation takes higher bit rates into account and allows in-service 
measurement as it relies on the evaluation of block errors. 

G.826 definitions: 

• Errored second (ES): A one-second time interval containing one or more errored 
blocks. 

• Errored block (EB): A block containing one or more errored bits. 

• Severely errored second (SES): A one-second time interval in which more than 
30% of the blocks are errored or which contains at least one severely disturbed 
period (SDP). 

• Background block error (BBE): An errored block that is not a SES. 

• Unavailable second (UAS): see under G.821 above. 

The results are referred to the measurement time. This gives the following error 
parameters: Errored seconds ratio (ESR), severely errored seconds ratio (SESR), and 
background block error ratio (BBER). The specified quality requirements refer too a 
particular path. 

The recommended measurement time for G.821 and G.826 is 30 days. 

13.2.3 Recommendation G.828 

Unlike G.826, recommendation G.828 provides a precise block length for each bit 
rate. For example, the number of blocks monitored per second for bit rates from VC3 
upwards remains constant at 8000. 

13.2.4 Recommendation G.829 

G.829 is based on the principle of monitoring block errors, allowing measurements to 
be made in-service. The recommendation defines the block size, number of blocks per 
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SDH frame, number of blocks transmitted per second and the error detection code 
(EDC) to be used for the various SDH bit rates that your ANT-5 supports. 

13.2.5 Recommendation M.2100 

Recommendation M.2100 specifically applies to commissioning and maintenance. 
Commissioning consists of a 15-minute line up phase followed by a 24-hour in-service 
measurement. Once the line up phase is completed successfully, errors may occur 
within certain limits. If this is the case, the line remains in service, but must continue to 
be monitored for a further 7 days. The measurement procedures are defined in 
M.2110 and M.2120. The limit values are derived from the performance parameters 
specified in G.821 and G.826. 

13.2.6 Recommendation M.2101 

This recommendation is very close to M.2100 in terms of purpose and format, but it 
deals exclusively with SDH systems. Recommendation M.2101 for SDH systems can 
be considered as a sister recommendation to M.2100 for PDH systems. 
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14. Appendix F – Simplified Chinese Language Support 
To display and print Simplified Chinese text, the ANT-5 Remote Operation Client 
program requires Windows XP and Windows code page 936. 

To setup support for code page 936 text services: 
1. Go to Start>Control Panel>Regional and Language Options, and then select 

the Languages tab.  
2. Under Supplemental language support, select Install files for East Asian 

Languages box. If this check box is already checked, go directly to step 5. 
3. Click OK. You may be prompted to insert a Windows CD-ROM at this time from 

which to copy the files. 

4.  After installation of the East Asian files is complete, reboot the system. 
5. Go to Start>Control Panel>Regional and Language Options, and then select 

the Advanced tab. 
6. Select Chinese (PRC) as the language version of the non-Unicode programs.   
7. Under Code page conversion tables, ensure that 936 (ANSI/OEM - Simplified 

Chinese GBK) is selected.   
8. Select the Languages tab. Under Text services and input languages, select the 

Details button.  
 The Text Services and Input Languages dialog box appears. 
9. Select the Settings tab, and then under Default input language, choose English 

(United States) - US.   
10. Click OK on the Text Services and Input Languages dialog box, and then click OK 

again on the previous dialog box.   
 Note: If a message appears stating: "The required files are already installed on 

your hard disk...", click Yes. 
11. After the language selection is complete, reboot the system. 
12. Run the ANT-5 Remote Operation Client application, and then select Chinese as 

the language on the General Preferences page. 
13. Exit, and then re-start the ANT-5 Remote Operation Client program. 

Note 1: The Ant5rc.exe application requires that the ANT-5 fonts (helv11.fon, 
helv13.fon, helv13b.fon, helf13x.fon, helv15.fon, helv15b.fon, helv22.fon, xm4x6.fon, 
xm6x10ex.fon, and xm7x14ex.fon) are located in either the installation target directory 
or that they have been installed into the Windows Control Panel → Fonts in order to 
display all standard ASCII characters along with the Chinese characters.  If these 
fonts are not available, the ASCII characters will be substituted as closely as possible 
by Windows, but the resulting text will not appear to fit correctly on the displayed 
pages. A TrueType font suitable for Chinese (such as SimSun) must also be available. 
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Note 2: When the PC has been configured to support code page 936, the ANT-5 
application may occasionally display incorrect characters when a language other than 
Chinese is selected because accented characters and printable control codes utilize 
codes beyond the standard 128 character ASCII set.  
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15. Appendix G – Glossary & Acronyms 

1-CDV 1-Point Cell Delay Variation 
2-CDV 2-Point Cell Delay Variation 
A1 Frame synchronisation byte; 1111 0110 (RSOH) 
A2 Frame synchronisation byte; 0010 1000 (RSOH) 
AAL-n ATM Adaptation Layer, Type n = 1, 2, 3/4 or 5  
ABR Available Bit Rate 
ACR Average Cell Rate 
ADM Add/Drop Multiplexer 
AIS Alarm Indication Signal 
ANSI American National Standards Institute 
APS Automatic Protection Switching (channels K1, K2) 
ARP Address Resolution Protocol 
ATM Asynchronous Transfer Mode 
AUG Administrative Unit Group 
AU-n Administrative Unit; Level n = 3, 4 
B1 BIP-8 parity word in regenerator section (RSOH) 
B2 BIP-N x 24 parity word in multiplex section (MSOH) 
B3 BIP-8 parity word in VC-3, 4 path (POH) 
BBE, BBER Background Block Error, Background Block Error Ratio 
BER, BLER, BERT Bit Error Ratio, Block Error Ratio, Bit Error Rate Test 
BIP-2 BIP-2 parity word in VC-1, 2 path (POH) 
BIP-N Bit Interleaved Parity; N bits 
BIS[P]O Bringing into service [performance] objectives 
C2 Signal label (VC-3, 4 POH) 
CAS Channel Associated Signalling 
CBR Constant Bit Rate 
CCM Cross-Connect Multiplexing 
CDV Cell Delay Variation 
CDVT Cell Delay Variation Tolerance 
CER Cell Error Rate 
CI Congestion Indication 
CLP Cell Loss Priority (low: CLP=1; high: CLP=0) 
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CLR Cell Loss Ratio 
CMIP Common Management Information Protocol 
C-n Container; n = 1, 2, 3, 4 
CPI Common Part Indicator 
CPS Common Part Sublayer 
CS Convergence Sublayer 
CSES Consecutive Severely Errored Seconds 
CTAN Channel Traffic Analyzer 
CTD Cell Transfer Delay 
CTM OAM Cell Type Mismatch 
D1-3 196 kbit/s DCC for regenerator section (RSOH) 
D4-12 576 kbit/s DCC for multiplex section (MSOH) 
DCC Data Communication Channel 
DCN Data Communication Network 
DM Degraded Minutes 
DS1 Electrical interface signal, 1544 kbit/s 
DS3 Electrical interface signal, 44736 kbit/s 
DSAP Destination Service Access Point 
DUT Device Under Test, either an individual item of equipment or a 

network element which is the interface to a larger system 
DXC Digital Cross-Connect 
E1 Electrical interface signal, 2048 kbit/s. Also service channel 

(voice) in regenerator section (RSOH). 
E2 Electrical interface signal, 8448 kbit/s. Also service channel 

(voice) in multiplex section (MSOH). 
E3 Electrical interface signal, 34368 kbit/s 
E4 Electrical interface signal, 139264 kbit/s 
EBC Errored Block Count 
ECC Embedded Communication Channel 
ECL Emitter Coupled Logic 
EDC Error Detection Code 
EFS Error-Free Second 
ESF Extended Super Frame 
ES, ESR Errored Second, Errored Second Ratio 
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F1 User channel, e.g. for operational service purposes (RSOH) 
F2 Path user channel for an end-to-end connection (POH) 
FAS Frame Alignment Signal 
FTM DS3 Frame Type Mismatch 
FTP File Transfer Protocol 
G1 End-to-end path status (POH) 
GFC Generic Flow Control 
GUI Graphical User Interface 
H1 Pointer byte 1: Bit nos. 1 to 4: New data flag; bit nos. 5, 6: 

(Unspecified); bit nos. 7, 8: Pointer value (highest 2 bits) 
H2 Pointer byte 2: Pointer value (lowest 8 bits) 
H3 Pointer byte 2: Negative justification opportunity 
H4 Payload indication (POH) 
HCOR Correctable header errors 
HEC Header Error Control 
HUNC Uncorrectable header errors 
HP Higher-order Path 
IAT Inter Arrival Time 
ICMP Internet Control Message Protocol 
ICP IMA Control Protocol 
IMA Inverse Multiplexing for ATM 
InARP Inverse Address Resolution Protocol 
IP Internet Protocol 
IS, ISM In-Service, In-Service Measurement 
ISDN Integrated Services Digital Network 
ISO International Standardisation Organisation 
J0 Regenerator section trace (RSOH) 
J1 Path trace (POH in VC-3, VC-4) 
J2 Path trace (POH in VC-12) 
K1, K2 APS channels for APS sig. & back-up line switching (MSOH) 
K3, K4 APS channels for APS sig. & back-up line switching (POH) 
LAN Local Area Network 
LCD Loss Cell Delineation 
LLC Logical Link Control 
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LO Lower Order 
LOF Loss Of Frame 
LOM Loss Of Multiframe 
LOP Loss Of Pointer 
LOS Loss Of Signal 
LP Lower-order Path or Loss Priority 
LSS Loss of Sequence Synchronisation 
M1 MS-REI byte (MSOH) 
MAC Media Access Control 
MBS Maximum Burst Size 
MCR Minimum Cell Rate 
MCTD Maximum Cell Transfer Delay 
MI Management Information 
MO Managed Object 
MPOA Multi-Protocol Over ATM 
MS Multiplexer Section 
ms Milliseconds 
MSOH Multiplexer Section Overhead 
MTIE Maximum Time Interval Error 
N1 Network operator byte for TCM in VC-3, VC-4 
N2 Network operator byte for TCM in VC-12 
NDF New Data Flag 
NE Network Element 
NFAS Not Frame Alignment Signal 
NLPID Network Layer Protocol Identifier 
NNI Network Node Interface 
OAM Operation, Administration and Management 
OC-N Optical Carrier; N = 1, 3, 12, 48, 192 
OH Overhead 
OOF Out-Of-Frame 
OOS Out-Of-Service 
OUI Organizational Unique Identifier 
PCR Peak Cell Rate 
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PDH Plesiochronous Digital Hierarchy 
PDU Protocol Data Unit 
PLL Phase-Locked Loop 
PLM Payload Label Mismatch 
PMP Protected Monitor Point 
POH Path Overhead 
PRBS Pseudo-Random Binary Sequence 
PRC Primary Reference Clock 
PPP Point to Point Protocol 
PPPoA Point to Point Protocol over ATM 
PPPoE Point to Point Protocol over Ethernet 
PTI Payload Type Identifier 
QoS Quality of Service 
RDI Remote Defect Indicator 
REI Remote Error Indicator 
ROSE Remote Operations Service Element 
RSOH Regenerator Section Overhead 
S1 Synchronisation status byte (MSOH) 
SAP Service Access Point 
SAR Segmentation and Reassembly 
SDH Synchronous Digital Hierarchy 
SCR Sustainable Cell Rate 
SDU Service Data Unit 
SEC SDH Equipment Clock 
SEFS Severely Errored Framed Seconds 
SELV Safety Extra Low Voltage 
SEP Severely Errored Period 
SES, SESR Severely Errored Second, Severely Errored Secs Ratio 
SHR, BSHR Self-Healing Ring, Bi-directional Self-Healing Ring 
SMN, SMS SDH management network, SDH management sub-network 
SN Sequence Number 
SNAP Sub Network Access Point 
SOH Section Overhead 
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SPE Synchronous Payload Envelope 
SPRING Shared Protection Ring 
SSAP Source Service Access Point 
SSCS Service Specific Convergence Sublayer 
SSSAR Service Specific Segmentation and Reassembly Sublayer 
SSTED Service Specific Transmission Error Detection Sublayer 
STM, STM-N Synchronous Transport Module; Level N = 0, 1, 4, 16, 64 
STS, STS-N Synchronous Transport Signal; Level N = 1, 3 
TIM Trace Identifier Mismatch 
TOH Transport Overhead 
TMN Telecommunications Management Network 
TSE Test Sequence Error 
TU, TU-m Tributary Unit; Level m = 1, 2, 3 
TUG-m Tributary Unit Group; Level m = 1, 2 
UAS, UAT Unavailable Second, Unavailable Time 
UBR Unspecified Bit Rate 
UI Unit Interval 
UNEQ Unequipped 
UNI User-Network Interface 
μs Microseconds 
UUI User to User Indication 
V5 POH byte (VC-1, 2) 
VBR Variable Bit Rate 
VC, VC-n Virtual Channel, Virtual Container; Level n = 1, 2, 3, 4 
VC-n-Xc Concatenated virtual container, level n, X concatenated VCs 
VCI Virtual Channel Identifier 
VP Virtual Path 
VPI Virtual Path Identifier 
VT Virtual Tributary 
WDM, DWDM Wavelength Division Multiplexing, Dense WDM 
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